User Manual for Graphical User Interface
Version 2.10 with Fire and Smoke Simulation Model (FSSIM) Version 1.2

TOMASZ A. HAUPT
GREGORY J. HENLEY
BHARGAVI SURA PARIHAR
ROBERT KIRKLAND
CAVS, Mississippi State University
Starkville, Mississippi

JASON E. FLOYD
JOSEPH L. SCHEFFEY
Hughes Associates, Inc.
Baltimore, Maryland

PATRICIA A. TATEM
Nova Research, Inc.
Alexandria, Virginia

FREDERICK W. WILLIAMS
Navy Technology Center for Safety and Survivability
Chemistry Division

May 10, 2010

Approved for public release; distribution is unlimited.
**REPORT DOCUMENTATION PAGE**

User Manual for Graphical User Interface Version 2.10 with Fire and Smoke Simulation Model (FSSIM) Version 1.2

Tomasz A. Haupt,* Gregory J. Henley,† Bhargavi Sura Parihar,‡ Robert Kirkland,* Jason E. Floyd,† Joseph L. Scheffey,† Patricia A. Tatem,‡ and Frederick W. Williams

Naval Research Laboratory, Code 6180
4555 Overlook Avenue, SW
Washington, DC 20375-5320

Office of the Secretary of Defense
1700 Defense Pentagon
Washington, DC 20301-1700

Approved for public release; distribution is unlimited.

The collaborative work of Hughes Associates, Inc. (HAI), the Naval Research Laboratory (NRL) and a group at Mississippi State University resulted in developing a simulation system including Graphical User Interface (GUI) and Visualization. The simulation environment provides a runtime environment for a third-party simulation package, Fire and Smoke Simulation (FSSIM) developed by HAI. This updated user’s manual for the viewer provides documentation of the GUI layout and detailed discussion of features of the output display.

This revision allows ships with aluminum infrastructure and allows the user to load out compartments for generic use types fuel load.

**15. SUBJECT TERMS**

FSSIM Smoke Fire Model

**16. SECURITY CLASSIFICATION OF:**

<table>
<thead>
<tr>
<th>a. REPORT</th>
<th>b. ABSTRACT</th>
<th>c. THIS PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unclassified</td>
<td>Unclassified</td>
<td>Unclassified</td>
</tr>
</tbody>
</table>

**17. LIMITATION OF ABSTRACT**

UL

**18. NUMBER OF PAGES**

122

**19a. NAME OF RESPONSIBLE PERSON**

Frederick W. Williams

**19b. TELEPHONE NUMBER**

(202) 767-2476
## CONTENTS

Contents ........................................................................................................................................ i

Rights and Restrictions ................................................................................................................ vii

1.0 Introduction ................................................................................................................................. 1

1.1 Overview of the Simulation Environment ................................................................................... 1

1.2 Fire and Smoke Simulator ........................................................................................................... 1

1.3 Running FSSIM and Analyzing the Results ................................................................................ 2

1.4 FireGUI ......................................................................................................................................... 3

2.0 Main Features of FireGUI ........................................................................................................... 4

2.1 Digital Representation of a Ship ................................................................................................... 4

2.2 Selecting a Compartment ........................................................................................................... 5

2.3 Active Objects ............................................................................................................................. 7

2.4 Preparing a Simulation ................................................................................................................ 8

2.4.1 Simulation Name and Duration .............................................................................................. 9

2.4.2 Ambient Parameters ................................................................................................................ 9

2.4.3 Selecting Ship Structural Material ......................................................................................... 10

2.4.4 Fire Sources .......................................................................................................................... 10

2.4.5 Fire Parameters ....................................................................................................................... 10

2.4.5.1 Fuel Loading ....................................................................................................................... 10

2.4.5.2 Fire Types (if no fuel loading is specified) ......................................................................... 11

2.5 Running a Simulation .................................................................................................................. 12

2.6 Real-time Visualization of the Simulation Results ..................................................................... 13

2.7 Replaying a Simulation .............................................................................................................. 16

2.8 Repeating a Simulation from an Existing Input File ................................................................. 17

2.9 Quantitative Analysis of the Results .......................................................................................... 19

2.10 File Management ........................................................................................................................ 20

3.0 Installation and Quick Start ...................................................................................................... 22

3.1 Minimum Computer Requirements ............................................................................................ 22

3.2 Installation .................................................................................................................................. 23

3.2.1 Installing the Software from the Enclosed CD ..................................................................... 23

3.2.2 Downloading and Installing MySQL ..................................................................................... 24

3.2.2.1 Downloading .................................................................................................................... 24

3.2.2.2 Installing ......................................................................................................................... 24

3.2.2.3 Testing ............................................................................................................................ 25

3.2.3 Directory Structure ................................................................................................................. 26

3.3 Quick Start Guide and Installation Test ..................................................................................... 27

4.0 Starting the FireGUI ................................................................................................................... 32

4.1 Accepting Rights and Restrictions ............................................................................................. 32

4.2 Selecting Geometry ..................................................................................................................... 32

4.3 FireGUI Defaults .......................................................................................................................... 33

4.3.1 Default color map and fuel loading ....................................................................................... 33

4.3.2 options.xml file ...................................................................................................................... 34

4.3.3 Namelist part of the options.xml ......................................................................................... 34

4.3.4 General part of the options.xml ........................................................................................... 35
## 7.3 Selecting Compartment using Show Compartment Tool ............................................. 64
## 7.4 Selecting Surface using Mouse Click ........................................................................ 65
## 7.5 Highlighting Surface using Show Surface Tool .......................................................... 65

### 8.0 Toolbar .................................................................................................................. 67

## 9.0 Menus .................................................................................................................... 70

### 9.1 File Menu ............................................................................................................. 70
- 9.1.1 General Options ................................................................................................. 70
- 9.1.1.1 Setting Global Options .................................................................................. 71
- 9.1.1.2 Setting Database Specific Options (Preferred Usetypes) ................................ 72
- 9.1.2 Color options .................................................................................................... 73

### 9.2 View Menu .......................................................................................................... 73

### 9.3 Help Menu .......................................................................................................... 73

## 10.0 Fire Simulation ...................................................................................................... 74

### 10.1 Preparing a Simulation ......................................................................................... 75
- 10.1.1 Setting the State of Active objects ................................................................. 75
  - 10.1.1.1 Doors, Hatches, and Scutelles ...................................................................... 76
  - 10.1.1.2 Archways (Smoke Curtains) ........................................................................ 76
  - 10.1.1.3 Ventilation System ...................................................................................... 76
  - 10.1.1.4 Suppression System ..................................................................................... 76
  - 10.1.1.5 Surfaces ....................................................................................................... 76
  - 10.1.1.6 Ratholes and Framebays ............................................................................. 77
- 10.1.2 Setting Simulation Parameters (Simulator tab) .................................................. 77
  - 10.1.2.1 Simulation Name, Description, and Duration ............................................ 78
  - 10.1.2.2 Ambient/General Parameters .................................................................... 79
  - 10.1.2.3 Structural Material ...................................................................................... 79
  - 10.1.2.4 Fire Sources ............................................................................................... 80
  - 10.1.2.5 Fire Parameters ......................................................................................... 81
- 10.1.3 Setting Fuel Loading (Compartment Usetypes) ............................................... 83
  - 10.1.3.1 Usetype Representation ............................................................................. 83
  - 10.1.3.2 Viewing Compartment Usetypes ............................................................... 84
  - 10.1.3.3 Loading, Editing, and Saving Usetypes ....................................................... 86
  - 10.1.3.4 Advanced User Options ............................................................................. 90

### 10.2 Running and Viewing Simulations ....................................................................... 90
- 10.2.1 Running ........................................................................................................... 90
- 10.2.2 Viewing Results .............................................................................................. 92
  - 10.2.2.1 Show Parameter ......................................................................................... 92
  - 10.2.2.2 Suppression System Activation ................................................................. 93
  - 10.2.2.3 Fire Spread ............................................................................................... 94
  - 10.2.2.4 Active Objects State Change ................................................................. 94
  - 10.2.2.5 Display Adjustment Tool .......................................................................... 95

## 11.0 Color Map and Legend ......................................................................................... 96

### 11.1 Legend ............................................................................................................... 96

### 11.2 Color Map Editing using Color Options Dialog ................................................... 96

### 11.3 Color Maps Tab ................................................................................................... 97
- 11.3.1 Color Map Representation ............................................................................ 98
- 11.3.2 Color Map Tab Controls ............................................................................... 99
- 11.3.3 Editing the Color Map ................................................................................... 100
- 11.3.4 How Color Mapping is Done ......................................................................... 100

### 11.4 Color Settings Tab .............................................................................................. 101
12.0 Accessing Data from Previously Run Simulations .............................................. 102
  12.1 Replaying Simulations (Replay tab) .................................................................. 102
  12.2 Comparing Two Simulations (Compare tab) ..................................................... 103
  12.3 Repeating a Simulation from an Existing Input File ....................................... 105
  12.4 Importing, Exporting, Renaming and Deleting Simulations ......................... 106
  12.5 Data Extraction for Quantitative Analysis ....................................................... 107
      12.5.1 Extracting Data ......................................................................................... 107
      12.5.2 Saving the Extracted Data ......................................................................... 109

13.0 Summary ............................................................................................................... 111

14.0 References ............................................................................................................. 112

Appendix A: Overview of V2.10 New Features (Since v2.8) ............................ A-1
  A.1 Fuel Loading (Compartment UseTypes) Editor .................................................. A-1
  A.2 Ship Structural Material Selector .................................................................... A-1
  A.3 Reorganization / Enhancements of the Fire Simulation Dialog Controls .......... A-1
  A.4 Shadwell Forward Database Enhancements ..................................................... A-1

Appendix B: Application CD ...................................................................................... B-1
RIGHTS AND RESTRICTIONS

Mississippi State University Copyright Information

Copyright 2003–2009, Mississippi State University, this material is based upon work supported by NRL Contract N00173-07-2-C008. Technical data transmitted directly from one computer or computer terminal to another shall contain a notice of asserted restrictions. Reproductions of technical data or any portions thereof subject to asserted restrictions shall also reproduce the asserted restrictions.

Asserted Restrictions

1. Restrictions. The software (“Software”) accompanying this notice contains copyrighted material, trade secrets and other proprietary material. In order to protect them and, except as permitted by applicable legislation, USER may not de-compile, reverse engineer, disassemble, or otherwise reduce the Software to a human-perceivable form, or otherwise attempt to discover the source code of any Software provided in compiled form; modify, network, rent, lend, loan, distribute or create derivative works based upon the Software in whole or in part; electronically transmit the Software from one computer to another or over a network; copy the Software, except USER may make one copy of the Software in machine-readable form for backup purposes only; or transfer USER’s rights in the Software, the backup copy of the Software, and the related documentation to another party.

2. Copyright and Trademark. The Software, Documentation and any authorized copies made by USER are owned by Mississippi State University (MSU). All title, ownership, rights, and intellectual property rights in and to the Software and Documentation shall remain with and in MSU. The Software and the Documentation are protected by the copyright laws of the United States and international copyright treaties. USER shall not use the names, logos, trademarks or any other mark or image considered by MSU to be identified with or protected by MSU, or those of any of its employees or former employees, or any adaptation thereof, in any advertising, promotional or sales literature without prior written consent being obtained from MSU in each case.

3. Export Law Assurance. USER hereby agrees that it shall not sell, transfer, export or re-export any Software or related information in any form, or any direct products of such information, except in compliance with all applicable laws, including the export laws of any U.S. Government agency and any regulations thereunder, and will not sell, transfer, export or re-export any such Software or information to any persons or any entities with regard to which there exist grounds to suspect or believe that they are violating such laws. USER shall be solely responsible for obtaining all licenses, permits or authorizations required from the U.S. and any other government for any such export or re-export.

4. Disclaimer of Warranty. MSU MAKES NO REPRESENTATIONS AND EXTENDS NO WARRANTIES OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED, TO WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE,
VALIDITY OF COPYRIGHT OR PATENT, ISSUED OR PENDING, OR FOR THE ABSENCE OF
LATENT OR OTHER DEFECTS, WHETHER DISCOVERABLE OR NOT DISCOVERABLE.
NOTHING IN THIS LICENSE AGREEMENT SHALL BE CONSTRUED AS A REPRESENTATION
MADE OR WARRANTY GIVEN BY MSU THAT THE PRACTICE BY USER SHALL NOT
INFRINGEMENT THE COPYRIGHT OR PATENT OF THIRD PARTIES. IN NO EVENT SHALL THE
MISSISSIPPI BOARD OF TRUSTEES OF STATE INSTITUTIONS OF HIGHER LEARNING, MSU
TRUSTEES, OR ANY OFFICERS, AGENTS OR EMPLOYEES THEREOF BE LIABLE FOR
INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY KIND, INCLUDING ECONOMIC
DAMAGE OR INJURY TO PROPERTY AND LOSS OF PROFITS, REGARDLESS OF WHETHER
MSU SHALL BE ADVISED OF, SHALL OTHERWISE HAVE REASON TO KNOW, OR IN FACT
SHALL KNOW OF THE POSSIBILITY THEREOF.

5. **Maintenance, support, and updates.** Software is provided to USER AS-IS.
MSU is under no obligation to maintain or support or update the Software in any way, or
to provide updates or error corrections.

---

**Hughes Associates, Inc. Copyright Information**

**GOVERNMENT PURPOSE RIGHTS**

<table>
<thead>
<tr>
<th>Contract No.</th>
<th>N00173-05-C-2009</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contractor Name</td>
<td>Hughes Associates, Inc.</td>
</tr>
<tr>
<td>Contractor Address</td>
<td>3610 Commerce Dr., #817</td>
</tr>
<tr>
<td></td>
<td>Baltimore, MD 21227-1652</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>April 18, 2010</td>
</tr>
</tbody>
</table>

The Government’s rights to use, modify, reproduce, release, perform, display, or disclose this software are restricted by paragraph (b) (2) of the Rights in Noncommercial Computer Software and Noncommercial Computer Software Documentation clause contained in the above identified contract. No restrictions apply after the expiration date shown above. Any reproduction of the software or portions thereof marked with this legend must also reproduce the markings.

Mississippi State University’s MySQL commercial license number: 481977
1.0 INTRODUCTION

1.1 Overview of the Simulation Environment

The Fire and Smoke Simulation Environment provides tools for simulation of fire and smoke spread on ships, submarines, and buildings and was jointly developed by Mississippi State University (MSU), the Naval Research Laboratory (NRL), and Hughes Associates, Inc. (HAI).

It is comprised of four elements: CAD processor, database, fire and smoke simulator (FSSIM) and graphical user interface (FireGUI) combined with a 3D visualization module, as shown in Figure 1-1.

![Figure 1-1 Simulation environment for fire and smoke simulations](image)

This manual describes the installation and use of the FireGUI only [1][2]. Descriptions of the CAD Processing [3][4], and in-depth details of FSSIM [5][6] are available in other papers, reports, and manuals. However, for convenience, the following section provides a brief description of FSSIM. (Note: FSSIM and demonstration databases do get installed when you install the FireGUI.)

1.2 Fire and Smoke Simulator

The need for fire modeling occurs through the “cradle-to-grave” lifetime of a ship, which encompasses the phases of concept design, detailed design and hazards evaluation, doctrine and tactics development, ship operations and maintenance, and crew training. In a concept design phase, fire modeling is needed to evaluate ship designs and design...
philosophies, in order to quickly arrive at an overall concept to meet required performance goals. As this concept is refined into a detailed design, fire modeling is continued to evaluate the ship vulnerability and recoverability and to begin the process of defining ship operation. Both of these phases could potentially require evaluating the fire behavior of a ship and its systems for hundreds of scenarios in design cycles spanning a few months time. Doctrine and tactical planning also require evaluating many separate scenarios in combination with a number of candidate doctrines. During the operational phase of a ship’s lifetime, fire modeling can support crew training through interactive training simulations. Fire modeling can also aid in the recovery from a fire event by providing faster than real time predictive capability to gauge the potential effectiveness of a course of action.

For each of the aforementioned uses of the fire modeling, speed and ability to model large, complexly interconnected spaces with ventilation, detection, and suppression, with a reasonable degree of accuracy, are performance requirements for the model. Hand calculations, while fast, have limitations in applicability and large uncertainties in their results. CFD computations have the potential to be accurate to any desired degree, but are slow. Zone models balance the computational time and accuracy well. However, in general, these models do not perform well with the ventilation systems and they lack the ability to model control systems. To meet the computational speed and algorithm requirements, the Fire and Smoke Simulator (FSSIM) has been developed by HAI as a network model [7].

A network model represents a one-dimensional abstraction of the physical world. The prototype being modeled is represented by a set of nodes and node connections, where the nodes contain one set of physical variables and the node connections represent the transfer of those variables between nodes. Contrast this with a zone model which uses two sets of variables or a CFD model that uses a multitude of variables. A network representation allows for maximum physical extent of a simulation with a minimum set of equations, one per geometric volume of interest. Since the number of locations being solved for is kept to a minimum, a network model also has the potential for faster execution speeds.

FSSIM is a network model written to simulate the spread of fire and smoke in a naval vessel. Providing the capabilities for faster than real-time modeling of numerous scenarios will enable doctrine and tactic planning, support personnel training, and aid the first responders should a disaster happen. The details of the FSSIM implementation and validation can be found in [5][6].

1.3 Running FSSIM and Analyzing the Results

The use of FSSIM as developed by HAI for running multiple what-if-scenarios on large ships or structures is hindered by the effort to create the input file that describes the structure to be modeled. The input file must comprise the description of every compartment, including the position and orientation of each bulkhead, the area of each wall, and the volume of each compartment. Furthermore, for each junction (e.g., door,
window, or archway), its location, orientation, size, and associated flow parameters must be given. Similarly, the description of all subsystems, such as ventilation or a fire suppression system, must be given as well. In addition, material properties, fuel properties, compartments’ fuel loading, and other simulation parameters must be included in the input file. All these descriptions must follow a specific format defined by the FSSIM developer. A typical FSSIM input file for a structure with tens or hundreds of compartments contains thousands of lines; and manual creation of the file is a tedious, error-prone, and costly procedure that needs to be performed by a well-trained operator, and may take weeks to complete and verify. A single run is never adequate to define a hazard, risk, or characteristics. It can be overwhelming to configure, run, and track various combinations of the input variables needed for a meaningful analysis of potential vulnerabilities and recoverability of a complex structure.

1.4 FireGUI

The advantage of using the simulation environment with the interactive GUI, as opposed to running just the simulation model, FSSIM, becomes most obvious when running multiple simulations on large structures. The database captures all aspects of the structure’s geometry, including material and fuel properties. Through the interactive GUI (henceforth referred to as “FireGUI”), the user sets up the simulation (e.g., the initial locations of fires, fire types, fuel loading, state of junctions and ventilation system) and then the input file for FSSIM is generated automatically, in less than a second. The results are visualized in real-time, giving the operator a very clear picture of the evolving situation. The results of simulations are stored, so that the simulations can be replayed at variable speeds (similar to replaying a TV broadcast recorded on a DVR) at any time without rerunning the simulation. Moreover, two simulations can be replayed simultaneously in split-screen mode for comparison purposes. Independently, the stored results of a simulation can be exported to a spreadsheet for off-line quantitative analysis.

The FireGUI maintains not only outputs of all previous simulations, but also the input files that created these results (by feeding them to FSSIM). This has many advantages. First, if any unexpected results are obtained, the input file can be loaded back to the FireGUI; that is, each element and property can be set back to the state at which they were when the input file was generated. Thus, the state of the structure and model parameters can be examined to see whether the unexpected results came from incorrect settings or not. Second, by loading the input file of a previous run, the operator may introduce an incremental change. For example, an aircraft carrier that we modeled for the U.S. Navy has thousands of doors. By default, all doors are closed. If for a particular scenario 200 doors should be opened, the user must click on each of them in order to open them. To run a similar scenario with 201 doors open, it is enough to load the input file of the previous run and open just one additional door. Third, the input file can be exchanged between users. This is of particular importance for providing crew training. An expert may prepare in advance a number of ‘standard’ scenarios and distribute them to trainees, who may be sailors without any deep knowledge about fire protection.
2.0 MAIN FEATURES OF FIREGUI

2.1 Digital Representation of a Ship

A few examples of the capabilities of FireGUI to visualize the geometry of the ship are shown in Figure 2-1. FireGUI features a 3D display of the ship (Figure 2-1A) enabling an interactive way of examining all aspects of the geometry with rotation, zoom, and translation (Figure 2-1B), showing or hiding of subsystems, such as doors and hatches (Figure 2-1C), spreading decks apart for a better view of the deck’s interiors (Figure 2-1D), and turning off the display of whole decks or individual compartments (Figure 2-1E). In addition, it provides a wireframe view (Figure 2-1F), a floor plan view of each deck (Figure 2-1G), and a 3D view of an individual compartment (Figure 2-1H). Detailed instructions are given in Section 4.0 and Section 6.0.

Figure 2-1. A series of FireGUI screenshots demonstrating the interactive capabilities
All operations described here can be performed at any time: when configuring a simulation, during the simulation, and while replaying a previously run simulation. For example, switching to the wireframe mode helps to see the layout of a particular subsystem that extends through many compartments, such as a fire suppression system, while configuring a simulation. When running or replaying the simulation, the wireframe mode provides the best way of watching the visualization of the spread of smoke.

2.2 Selecting a Compartment

To select a compartment, the user can just click on it (either in the 3D display or in the floor plan, Figure 2-2), or, alternatively, by selecting it from the list in which the compartments are sorted by deck, frame, and position (Figure 2-3).

The selected compartment gets highlighted in both 3D view and floor plan view (Figure 2-2). In addition, the selected compartment is displayed in the compartment viewer (bottom right corner of Figure 2-2).
The compartment viewer allows the user to examine the geometry of the compartment (it can be zoomed in and rotated independently of the overall 3D display), and see the compartment designation (deck-frame-position) and name. Most importantly, the compartment viewer allows the user to select a surface (bulkhead/overhead/deck) to be marked as damaged. The extent of the damage is specified by the area of the rupture expressed as the percentage of the total area of the surface (Figure 2-4D; details in Section 10.1.1.5).

To run a simulation, at least one compartment must be selected as a fire source. Detailed instructions on selecting compartments are given in Section 7.0 and setting the fire source in Section 10.1.2.4.
2.3 Active Objects

Many elements displayed in the 3D view are referred to as “active objects”, that is, elements that the user can interactively change their state (such as doors that can be opened or closed and fans that can be switched on and off). The state of an active object is visualized by the color of the element. For example, an open door is rendered in white, while a closed door is shown in black (Figure 2-4A). Similarly, an archway is rendered in white, and the same archway covered by a smoke curtain is shown in black (Figure 2-4B). In general, a light color represents “open” or “on”, and a dark color represents “closed” or “off”. For example, a switched-on fan is shown in light blue, and when it is turned off it is dark blue; a closed damper is brown, and an opened damper is yellow (Figure 2-4C). Also, a surface can be specified to be damaged by a given percentage (Figure 2-4D).

The state of active objects can be changed interactively, and the instructions on how to do that are given in Section 10.1.1. By closing and opening doors, scuttles and hatches,
switching devices on and off and setting other parameters, the user configures the ship for a simulation.

The entire configuration must be performed before the simulation is started: any changes of the state of the active objects after the user clicks the “start” button will not affect the running simulation. However, the state of some active objects can be “pre-programmed” to change during the simulation. For example, a fan can be set to activate at a specified time (e.g., 90 seconds into the simulation), or the fire suppression system can be activated when some predefined event happens (e.g., when the compartment’s temperature rises above a specified threshold). More details can be found in Section 10.1.1.3 and Section 10.1.1.4.

### 2.4 Preparing a Simulation

A simulation is defined by an input file for FSSIM. It is created automatically by the FireGUI by combining the information stored in the database (geometry and material properties), the state of the active objects in the 3D view, as well as fire properties and simulation parameters, both to be provided interactively by the user. The input file is created when the user presses the “start” button.

The FireGUI follows strictly the approach: “What You See Is What You Get”. The values of all properties used to create the input file are those that are currently displayed on the screen or can be seen through various pop-up windows that reveal the current values of specific properties.

When the geometry is first loaded, the state of the active objects, structural parameters, and some other properties, including compartment fuel loading, ambient conditions, or color maps are set to default values. The preparation or configuration of the simulation simply means setting new values for the properties. At any time during the configuration process, the user can reset the FireGUI to the default values using the Newsim button described in Section 10.2.1.

As described in detail in Section 4.3, the user may define new defaults (such as a custom color map or fuel loading) that are set when loading or resetting the geometry instead of those initially defined in FireGUI. The user can always return to the “factory settings” later.

Alternatively, instead of setting the simulation properties by changing their default values using interactive features of FireGUI, the user may load an existing input file from a previous run or obtained from another user, as described in detail in Section 12.3 and Section 12.4. In this case, all the properties in FireGUI are automatically set to the values used to run that simulation. After the loading the input file the simulation can be immediately rerun as is, or the settings can be incrementally modified.
To prepare a simulation the user should perform the following steps:

- Name the simulation and set its duration
- Optionally, set the state of the active objects, as described in Section 2.3 above
- Optionally: set the structural material (if alternatives are available), as described in Section 2.4.3
- Select at least one fire source
- For each source set the fire properties

Finally, an existing input file can be opened in a text editor, modified manually, and loaded back to FireGUI. This is an error prone procedure and should be avoided. Mistakes introduced by the user to the input file may result in unexpected behavior of the FireGUI. Only very experienced users with expert knowledge of FSSIM should attempt to modify the input file manually.

2.4.1 Simulation Name and Duration

Despite the fact that the input file is generated on the fly, it is not a transient object. It is always saved as a file, so that it can be reused at a later time. The existing input file can be loaded back to FireGUI to rerun the simulation with or without modifications, or the file can be copied and given to another user. Therefore, the input file must be named and, optionally, the user may provide a brief description of the simulation. Please refer to Section 10.1.2.1 for details.

The user also has to specify the desired duration of the simulation in terms of the simulation time. The actual time to run the simulation, as measured by a wall clock, depends on the size of the ship and its configuration.

2.4.2 Ambient Parameters

The default values of ambient conditions like temperature, oxygen, pressure should be sufficient for most simulations. In case the user has more unusual circumstances, these values can be modified (Figure 2-5). For more information, refer to Section 10.1.2.2.
2.4.3 Selecting Ship Structural Material

The structural materials are predefined in the database. In this release (FireGUI 2.10) one geometry (Shadwell Forward), provides three predefined alternative structural materials that can be chosen by the user (Figure 2-6). This feature is described in Section 10.1.2.3. This changes the structural material of the entire ship. For example, all surfaces which were carbon steel are changed to aluminum-5000 series. Changing an individual surface’s material is not presently supported directly from the GUI.

2.4.4 Fire Sources

A fire source is set by selecting a compartment and adding it to the list of fire sources (Figure 2-7). FireGUI supports multiple fire sources that can be added to the list, one at a time. For more information, refer to Section 10.1.2.4.

2.4.5 Fire Parameters

The initial fire type of a fire source depends on the fuel loading of the compartment: if the load is not specified, by default, the fire type is a constant 100kW fire; if the load is specified, the fire type is usetype. The fuel loading and fire type can be changed as described in the following sections.

2.4.5.1 Fuel Loading

The database provides a default fuel loading of compartments for each ship. The loads can be viewed and modified (Figure 2-8). The modified loads can be saved in a file for future use. Furthermore, one of the saved loads can be set as a new default. In that case, it will be automatically loaded instead of the loads defined in the database. On the other
hand, if a specific fire type (constant, \( t^2 \)) is to be used, no fuel loading should be specified and FireGUI provides an easy way to clear the loadings. For more information, refer to Section 10.1.3.

2.4.5.2 Fire Types (if no fuel loading is specified)

If no fuel loading is specified, the fire type can be constant or \( t^2 \). For a constant fire, the power can be changed (Figure 2-9A). For a \( t^2 \) fire type (Figure 2-9B) its growth speed, \( t^2 \) power, and \( t^2 \) time can be specified. The user can also specify fire start and end times for a constant or \( t^2 \) fire (Figure 2-9C). Furthermore, the user may adjust the default fire source fuel parameters (Figure 2-10). For more information, refer to Section 10.1.2.5.
2.5 Running a Simulation

After the simulation setup is complete, the user can start the simulation by pressing the “start” button. The FSSIM input file is then automatically generated and the FSSIM simulation is initialized. The results of the simulations are read by FireGUI in real time and visualized. Independently, the results are stored in a file. The output file can be used to replay the simulation at a later time, that is, the evolution of the fire can be visualized again without actually running the simulation or it can be compared with the results of another simulation.
When the simulation is run or replayed, the analog and digital clocks show the current simulation time and the vertical progress bar just to the right of the analog clock shows the percentage of simulation that is completed (Figure 2-11). At anytime, the simulation can be paused and resumed, or stopped (abandoned) (Figure 2-12). For details, refer to Section 10.2.1 and 10.2.2.1.

![Figure 2-12. Simulation can be paused (left), resumed (center), or stopped (right). The status bar shows the action performed such as 'Paused'.](image_url)

### 2.6 Real-time Visualization of the Simulation Results

The results of the simulations are visualized in real-time in both the 3D and floor plan views. FireGUI visualizes four variables (one at a time): temperature inside a compartment, smoke density, toxicity (i.e., concentration of CO), and oxygen level; in addition, temperature and smoke can be displayed at the same time. All variables except smoke are visualized using color (Figure 2-13), and smoke is visualized using gray plus transparency, with full visibility (no smoke) as fully transparent to zero visibility (heavy smoke) as almost fully opaque. In the 3D view, smoke is best seen in the wire frame mode of the ship (Figure 2-14). Refer to Section 10.2.2 and 10.2.2.1 for details.
Figure 2-13. Simulation result (oxygen concentration) is shown as colored compartments along with the legend in 3D and floor plan views. Oxygen concentration is very low in two compartments (red) and somewhat low in several others (yellow). Fire has spread to the neighboring compartment (pink outline with tick marks).

Figure 2-14. Smoke propagation (visibility) shown as a gray transparency in wire frame mode. The fire source compartment has more smoke and less visibility and therefore is more opaque than the neighboring compartments.

The mapping between the color or transparency and the actual value is shown in the legend, which is shown in both Figure 2-13 and Figure 2-14. The default mapping is non-linear to emphasize inhabitability of compartments. For example, a compartment is not
colored at all if it is safe for the crew to be inside it. If the temperature is between 60°C and 165°C, a properly equipped firefighter should survive in these conditions, and thus the color is the same for any value between 60°C and 165°C inclusive.

The color map can be modified using a dedicated editor (Figure 2-15), and optionally, the modified color map can be set as a new default (Section 9.1.1). For illustration purposes, Figure 2-16, compares visualizations of same simulation with different color maps applied. For details, refer to section 11.0.

Figure 2-15. Editing color map legend using color options dialog. The user can specify the range of values and a color for each range and can preview it before saving.

Figure 2-16. Simulation results using default color map with yellow and red (left) and user defined custom color map with blue, green, and red (right)
In addition to visualizing changes of the values of the four variables as the simulation progresses, the spread of the fire to other compartments is shown (Figure 2-17, Section 10.2.2.3).

Moreover, if during the simulation the state of an active object changes (Section 2.3 above), the change is visualized in real time. As an example, Figure 2-18 shows the fire suppression system activated after the temperature inside the compartment increases above the pre-defined threshold value (Section 10.2.2.2).

2.7 Replaying a Simulation

A simulation can be replayed (Figure 2-19A) or compared in a split-screen view to another simulation of the same ship (Figure 2-19B). In the replay mode, the results are read from the existing output file, as opposed to running FSSIM simulation again and reading new results in real time. Because the simulation is not running, replays are much faster than real-time simulations. To make the replay more useful, FireGUI offers several
options to slow down the visualizations. The details are described in Sections 12.1 and 12.2.

2.8 Repeating a Simulation from an Existing Input File

Any simulation can be also repeated, as opposed to “merely” being replayed. In that case, an existing input file is reused as opposed to reusing the output file when replaying a simulation. However, depending on the user’s choice, after loading the input file the FireGUI will behave in two different ways, as described below.

As it is explained in Section 2.5, FireGUI generates FSSIM input files by combining the information from the database, the state of the active objects in the 3D view, and user-provided fire properties and simulation parameters. If the user loads an existing input file to the FireGUI, the user must provide a new name for the input file; otherwise, the loaded one will be overwritten (with the user’s approval). The state of the active objects as well as fire parameters is transferred from the old file to the new one. However, the information that comes directly from the database is not transferred; it will be created anew. Consequently, loading the existing input file just saves the user the time and effort to reproduce the configuration of the simulation represented by the existing deck. Once the configuration is restored, the user may continue modifying the configuration, introducing incremental changes (Figure 2-20). Detailed instructions are given in Section 12.3.

Alternatively, the user may force FireGUI to accept the loaded input file ‘as is’. In this case no information from the database is used, and any FireGUI support for editing the configuration of the simulation is disabled (Figure 2-21). This is an “escape mechanism”
for very experienced FireGUI users with expert knowledge of FSSIM that allows introducing arbitrary changes to the FSSIM input file using an external text editor or other tool. In this case, FireGUI performs no error checking, and therefore, the errors in the input file introduced by the user may lead to an unexpected behavior of FireGUI. The ‘best effort’ approach is applied to make the visualization correct.

A. When an existing input file is loaded, the simulation parameters and active object states are read from the file and set in the GUI. Note that the door is open.

B. The user can now change the simulation parameters, change active object states, run the simulation, and see the new results. In this example, the user changed input name, description, structural material, and closed an open door.

Figure 2-20 Using an existing file as the basis for setting simulation parameters
2.9 Quantitative Analysis of the Results

As useful as the real-time visualizations are, in many cases, a quantitative analysis of the simulation results needs to be done. To support that, the data can be extracted from the FireGUI in the form of spreadsheets, and then analyzed by external tools of choice. Since a typical simulation generates a large volume of results, the FireGUI allows the user to specify a particular subset of data to be extracted. Figure 2-22 shows an example, where the time history of temperature for two selected compartments is extracted and plotted using Microsoft’s Excel. The data extraction is discussed in detail in Section 12.5.
Figure 2-22 Data Extraction dialog is used to extract the data for compartments 214 and 216 for temperature from 500 to 1600 seconds. Extracted data is shown as MS Excel spread sheet. The data can be plotted for analysis using Excel plotting features.

2.10 File Management

All input and output files generated by FireGUI are stored in what is referred to as a “simulation repository”. The repository has a specific structure to simplify preserving the integrity of files, so that the previously run simulations can be found, replayed, compared and rerun. For the sake of the integrity of the repository, users are discouraged to access these file directly by using Windows File Browser or other applications. Instead, FireGUI provides means for exporting or importing the files from and to FireGUI. Exporting a file means making a copy of it at the location specified by the user, and importing is inserting a copy of the file from the location specified by the user to the repository.

If an FSSIM input file has been manually edited outside FireGUI, or is obtained from another user, and therefore does not exist in the simulation repository, the input file can be imported into the repository. Then the user can open it from the GUI and use it ‘as is’ or incrementally change the parameters. The user can also import both input and output files into the repository and use replay to see the results.

Similarly, the user can export the input and output files from the repository to share the files with other users or to archive them (Figure 2-23). Refer to Section 12.4 for details.
Figure 2-23 Using Available Simulation pop-up window input and output files can be exported from or imported to the FireGUI repository.
3.0 INSTALLATION AND QUICK START

3.1 Minimum Computer Requirements

The video and main memory requirements are a function of the size of the geometry or number of compartments you wish to run. Also with the myriad of CPU, memory, graphics card, and operating system combinations, performance can vary greatly. Exceeding these minimum requirements can bring additional performance to bear and shorten simulation times further.

System Summary:
- Operating System: Windows Vista or XP
- Processor: 1.8 GHz Pentium 4 Processor or equivalent for desktop
  1.7 GHz Pentium M or equivalent for laptop
- Total Physical Memory: 1GB for Vista, 512 MB RAM for XP

Display:
- Adapter Type: Any with OpenGL acceleration (workstation class hardware 3D acceleration)
- Adapter RAM: 128 MB Video RAM
- Resolution: 1280x1024 screen resolution

Other requirements:
- a 3-button mouse (or mouse with wheel)
- MYSQL database software (recommend MySQL 5.1)

Checking Computer Requirements:

To check to see if your computer meets the minimum requirements given above, several of the parameters listed above can be determined by following these instructions. First, click on “Start” then click on “All Programs”, then “Accessories”, then “System Tools”, then “System Information” to bring up the System Information window. When this window first appears, you should see the System Summary information in the right side of the window which contains the OS Name, Processor (which should include speed in MHz or GHz), and Total Physical Memory. To see graphics related parameters, in the left side of the window, click on the plus symbol beside the Components item to expand it, then select Display. Now the right side of the window should contain Adapter Type, Adapter RAM (Video RAM), and Resolution.
3.2 Installation

3.2.1 Installing the Software from the Enclosed CD

1. You should have administrative privileges on the computer to install the software. Double click setup.exe from the CD to start the installation. Click "Next" to choose the installation location. By default, it will install in "C:\Program Files\MississippiStateU\FireModelNetworkGUI_v2.10\". Keep clicking "Next" to finish the installation. The installation process will create a shortcut for the executable on the desktop and an entry under “Mississippi State University” in the Windows Programs menu.

2. This software depends on the MySQL database software, so if you do not already have it installed, follow the instructions under “MySQL Installation” (Section 3.2.2) below and then return here to continue.

3. From the command prompt (one way to access: click on “Start”, click on “Accessories”, click on “Command Prompt”), change to the directory where the CD contents were installed.

4. From that prompt, type “cd Application”.

5. From “……/Application>” prompt, type “cd Databases”.

6. If you have added MySQL commands to your PATH (when the MySQL installation wizard was run and the step h.ii followed under installation on pg. 25), from “……/Databases>” prompt, type the command “mysql --user=root < loadDemos.sql”.

7. Exit from the Command Prompt environment and go back into the Windows environment.

8. You can launch the application by double clicking the desktop shortcut “FireGUI_v2.10.exe” or from the Windows menu

     Start->All Programs->Mississippi State University->FireGUI_v2.10.

9. Alternatively, you can launch as follows. From Windows Explorer, change to directory where you have installed the software. Double click on "Application". Double click on "Executable". Double click on "FireGUI_v2.10.exe" to run the application.

Transferring Data from an Older Version

If you would like to transfer all of the simulations from an older version of FireGUI, you may copy the entire simrep folder from the old installed location to the new location. i.e., copy the folder <old location>\Application\Executable\simrep to the C:\ProgramFiles\MississippiStateU\FireModelNetworkGUI_v2.10\Application\Executable folder (or wherever you installed the software). This will replace the newly installed simrep folder which only contains a couple of demo runs for each geometry with your preexisting simrep folder. Transferring simulations only works if the database has not changed between FireGUI revisions.

Note: Shadwell_Forward database has changed between versions 2.8 and 2.10.
3.2.2  Downloading and Installing MySQL

This document provides a brief guide to downloading and installing the MySQL database server software on a Microsoft Windows-based PC. It is recommended to have your system administrator install this, especially if you are unfamiliar with installation procedures. We currently recommend MySQL Community Server version 5.1. **(NOTE: The following download instructions were verified as of this writing (January 2010), but websites sometimes change frequently.)**

3.2.2.1  Downloading

1) There is a lot of information and downloads available on the MySQL website, which can make navigating to the correct download link challenging. To get to the download page:
   b. Near the top left of the webpage, select “Downloads”
   c. This should bring you to the “MySQL Downloads” page.

2) Once at the “MySQL Downloads” page, look for the heading “MySQL Community Server”. Click on this link or the corresponding download link just below.

3) The page that comes up should show Generally Available (GA) Releases (**you may have to scroll down**) and will provide several choices for different operating systems. Select Platform as **Microsoft Windows** if not already selected, then from the list of files to download click **Download** beside “Windows (x86, 32-bit), MSI Installer” **(In January 2010, the current version is 5.1.42 and the filename is mysql-essential-5.1.42-win32.msi.)** or get the 64-bit edition if you need it.

4) On the next page, fill out the requested information (if you like), or just follow the link to the downloads (on the bottom of the page).

5) Select a download server (“mirror”) from which to download the software.

3.2.2.2  Installing

1) The .msi file you just downloaded can be started by double clicking it. The default selections can be followed in the install process.

2) At the end of the initial install process, the checkbox for “Configure the MySQL Server” is checked by default. Leave this checked to configure the server when you finish the install process. Click “Finish”.
3) When going through the Server Configuration Wizard screens, most of the items can be left as defaults, though some will need to be altered as appropriate (namely, step h.ii. and step i below):

   a. Configuration Type: “Detailed Configuration” (default)
   b. Server Type: “Developer Machine” (default)
   c. Database Usage: “Multifunctional Database” (default)
   d. Drive for InnoDB File. Simply click the “Next >” button to keep the defaults
   e. Number of Connections: “Decision Support (DSS)/OLAP” (default)
   f. Networking Options: “Enable TCP/IP” (checked by default)
   g. Character Set: “Standard Character Set” (default)
   h. Windows Options:
      i. “Install as Windows Service” (checked by default)
      ii. “Include Bin Directory in Windows PATH” (not checked by default). This item should be CHECKED.
   i. Security Options: “Modify Security Settings” (checked by default). This item should be UNCHECKED. This will gray out the other settings.
   j. On the next screen, click the “Execute” button to finish the configuration.

4) NOTE: With MySQL 5.1.x, one additional step to grant privileges to the null user at localhost is required for the FireGUI Software to operate. In a command prompt window (see windows help if you don’t know how to do this) type:

   mysql --user=root

   which should give you a prompt “mysql>”. At the “mysql>” prompt, type:

   grant all on *.* to ''@localhost;

5) These steps complete the installation of MySQL. Below are instructions to quickly check for a successful installation.

3.2.2.3 Testing

   1) After completing the installation wizard, in a command prompt window type “mysql --user=root” to see if it successfully connects to the database server. It should give you a prompt “mysql>”.
   2) At the “mysql>” prompt, type “show databases;” to see the default databases. If you have been successful, you should see on your monitor at least the following (if previously installed you may see additional databases in the list):

   mysql> show databases;
   +----------------+
   | Database       |
   +----------------+
   | mysql          |
   | test           |
   +----------------+
   2 rows in set (0.06 sec)
3) Type "quit" to exit. Now you should be ready to continue with step #3 from the above section 3.2.1 “Installing the Software from the Enclosed CD”.

### 3.2.3 Directory Structure

Successful installation of the FireModelNetworkGUI software creates a directory called the FireModelNetworkGUI_v2.10 at the chosen location. This folder contains a subdirectory called Application (as shown in Figure 3-1). The Application directory contains three subdirectories: Databases, Executable, and Images.

The Databases directory contains four demonstration databases and a script to load them. The Executable directory contains the GUI executable plus its required dll files, two configuration files called Options.xml and dbconfig.txt, the HAI FSSIM network model executable (version 1.2), and a subdirectory, simrep, which serves as a simulation repository for storage of results of simulations. The Images directory contains graphical images used by the GUI.

**Software has been tested on the following which meet or exceed minimum computer requirements:**

1) 2.6 GHz Pentium 4 desktop, 512 MB RAM, Windows XP, ATI Radeon Fire GL 8800 w/128 MB Video RAM, running at 1280x1024 screen resolution. This machine performs very well on all demo databases.

2) 1.7 GHz Pentium M laptop, 512 MB RAM, Windows XP, ATI Mobility Fire GL T2 w/128 MB Video RAM, running at 1400x1050 screen resolution. This machine performs very well on all demo databases.

3) Dual Processor AMD Athlon 2400+, 2 GB RAM, Windows 2000 SP4, Nvidia GeForce4 Ti 4400 w/128 MB Video RAM. This machine performs very well on all databases.

4) 2.3 GHz Intel Core 2 T7600 laptop, 3 GB RAM, Windows XP, ATI Mobility FireGL V5250 with 512 MB video RAM, running at 1400 x 1050 screen resolution. This machine performs very well on all demo databases.

5) Dual Processor AMD 64-bit Opteron 2.59GHz, 4 GB RAM, Windows XP or Windows Vista, dual NVIDIA Quadro FX4500 w/512 MB Video RAM each, running at 2560x1600 screen resolution. This machine performs very well on all databases.
Software was also tested on the following which fall below the minimum requirements in one or more categories:

1) 1.8 GHz Pentium 4 desktop, 256 MB RAM, Windows XP, Nvidia GeForce2 MX/MX 400 w/64 MB Video RAM, running at 1600x1200 screen resolution. This machine performed very well on graphics and satisfactory on simulations.

2) 2 GHz Intel Core 2 Duo laptop, 2GB RAM, Windows Vista Home, Nvidia GeForce 8400 MGS w/64 MB dedicated video memory and total 830 MB shared video memory, running at 1280 x 800 screen resolution. This machine performed well on graphics and simulations on all databases.

3) 2.4 GHz Pentium 4 laptop, 512 MB RAM, Windows XP, ATI Radeon 7500C w/32 MB Video RAM, running at 1280x1024 screen resolution. This machine performed satisfactory on Confined_Space; not as good on Building_B and Ship_A.

4) 2.8 GHz Pentium 4 laptop, 512 MB RAM, Windows XP, ATI Mobility Radeon 7500 w/32 MB Video RAM, running at 1024x768 screen resolution. This machine had difficulty loading the more complex geometries.

3.3 Quick Start Guide and Installation Test

This section provides a very simple example of the steps to run a simulation. Successfully following these steps and seeing simulation results similar to the final step should also verify that the installation was correct. Double-click the shortcut on the desktop “FireGUI_v2.10” to start the application.

Step 1: The Database Selection dialog (shown in Figure 3-2) pops up. From the drop down menu, select the Confined_Space database (Confined_Space) and click OK.

![Figure 3-2 Database selection](image)

This should bring up the main Fire Model Network GUI (FireGUI) window (Figure 3-3).
Step 2: Click the Fire Simulation button on the main FireGUI window as shown in Figure 3-3.

Two new popup windows should appear named Fire Simulation and Object State Editor (Figure 3-4).
Step 3: To add a fire source, first select a compartment from the floor plan or 3D view by clicking the left mouse button on it. For this test, we will use the compartment number “13: torpedo room (3-74-2)” as shown in Figure 3-5. Once the compartment is selected, it is highlighted in green color (Figure 3-5). Then click the AddFire button on the Fire Simulation popup (Figure 3-6) and the Location box will contain the added fire source (Figure 3-7). Additional fire sources can be added similarly but for this test, we will use only one.

Figure 3-5 Selected compartment (torpedo room) is highlighted in green color

Figure 3-6 'Add Fire' button on Fire Simulation popup
Step 4: Change the Power to 1000 (Figure 3-7)

![Figure 3-7 Power settings for a constant type fire](image)

Step 5: In the object state popup window (Figure 3-8), check the *Include FrameBays* box. This currently applies only to the Confined_Space.

![Figure 3-8 Including framebays in the Object State Editor](image)
Step 6: In the Fire Simulation popup (Figure 3-9), Click the *Start* button

![Start button starts simulation](image)

Step 7: The object state editor will be hidden, the program should start running, and in a few seconds you should see compartment 13 turn yellow, then red as simulation runs, and another compartment turn yellow as shown in Figure 3-10. This simulation should stop when the time reaches 100 seconds (the default time).

![Simulation visualization in 3D and floor plan views](image)

The remainder of this document provides more details on setting up, running, and viewing simulations.
4.0 STARTING THE FIREGUI

To launch the FireGUI double click the FireGUI icon labeled “FireGUI_v2.10” on the desktop. The application starts with the pop up window shown in Figure 4-1. The pop-up prompts for accepting the rights and restrictions and selecting the ship to be modeled.

4.1 Accepting Rights and Restrictions

The pop-up displays the Rights and Restrictions. The text is identical to that printed at the beginning of this manual on page v. By clicking OK the user accepts these terms of use.

The FireGUI comes preloaded with databases comprising geometries and properties of several ships. By default, “Shadwell_Forward” is loaded.

4.2 Selecting Geometry

If the database of a ship other than Shadwell_Forward is to be opened, select the geometry from the drop-down list in the bottom left corner of the pop-up before clicking the OK button. Clicking OK brings up the main FireGUI window displaying the selected ship as shown in Figure 4-2. This initial choice of ship can be changed at any time directly from the main FireGUI window using the “change geometry” widget, as described in Section 6.1.

The available geometries and number of compartments included with FireGUI V2.10 are:
1) Shadwell_Forward (159 compartments)
2) Confined_Space (23 compartments)
3) Ship_A (175 compartments)
4) Building_B (137 compartments)

Figure 4-1 Database selection

Select database
4.3 FireGUI Defaults

When the main FireGUI window starts, it loads a configuration file that defines the default behavior of several aspects of FireGUI.

4.3.1 Default color map and fuel loading

FireGUI comes with a predefined color map that is applied to all ships, and a predefined fuel loading for each ship. Since some users may want to change them, the FireGUI also provides dedicated editors to modify these predefined color maps and fuel loadings, described in Sections 11.2 and 10.1.3, respectively. The edited color mappings and loads are transient, that is, they are applied just to the current simulation but lost when they are changed again, or if the FireGUI software is exited. To make the changes persistent, the user needs to save changes into a file using the editor controls. The saved changes can be loaded back to the FireGUI at anytime, during the current or subsequent FireGUI sessions. Finally, the saved map or loads could be set as a new default. In such a case, the user defined color map and/or fuel loads are loaded to the FireGUI when the FireGUI is started. The initial, predefined color maps and loading can be restored at any time, if needed. These and other FireGUI settings and defaults are defined in the options.xml (Section 4.3.2) file and files referenced by it.
4.3.2 options.xml file

For most users, the defaults specified in the options.xml file should be acceptable, but can be changed by advanced users if necessary. Some of the fields within this file can be modified by using the FireGUI (and this is the recommended way to modify them) File Menu  General Options (Section 9.1). The contents of the options.xml file are shown in Figure 4-3.

```
<OPTIONS>
  <Namelist>
    <NLFileExt>txt</NLFileExt>
    <NLDescTag>!Desc</NLDescTag>
  </Namelist>

  <General>
    <ColorSettingsFile>ColorSettings.xml</ColorSettingsFile>
    <DBConfigFile>dbconfig.txt</DBConfigFile>
    <SimArchDir>simRep</SimArchDir>
    <ExtractArchPath/>
    <DataViewerPath>C:\Program Files\Microsoft Office\OFFICE11\EXCEL.EXE</DataViewerPath>
    <SortAngle>0.98</SortAngle>
  </General>
</OPTIONS>
```

Figure 4-3 Contents of options.xml

The configuration file is written in XML, and it is divided into two parts: “Namelist” and “General”. The options in the options.xml configuration files can be changed by editing the file manually. The options.xml file is located in the same folder as FireGUI executable (Section 3.2.3). Open the file using a text editor of choice (Microsoft’s wordpad or notepad will do the job), and modify the text as explained below. As recommended above, ColorSettingsFile, ExtractArchPath, and DataViewerPath of the General part can be modified by using the options.xml dialog launched from the File Menu  General Options (Section 9.1). The paths and filenames specified are not case sensitive (upper/lower case usually does not matter for MS Windows paths/files). One other note: If the user accidentally damages the options.xml file which causes the FireGUI to not start up properly, the options.xml file can be restored by deleting the file and restarting the FireGUI which will recreate the file with factory defaults.

4.3.3 Namelist part of the options.xml

The Namelist part defines some implementation details. It should not be modified by the user.
4.3.4 General part of the options.xml

The General part comprises six sections:

4.3.4.1 ColorSettingsFile

ColorSettingsFile defines the location of the default color map (Section 11.0). To change the default color map use the color map editor and save it as a file (Section 11.0). To make a color map the default, write its location between the <ColorSettingsFile> and </ColorSettingsFile> tags in the options.xml file.

This change can be made using the options.xml dialog opened from the File Menu→General Options (as opposed to editing the options.xml file).

4.3.4.2 DBConfigFile

DBConfigFile defines the location of the database configuration file, whose content is shown in Figure 4-4.

<table>
<thead>
<tr>
<th>DBname, clearUsetypes, preferredUsetypes file, Usertype Majors File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shadwell_Forward, true, default, usetypeColors.txt</td>
</tr>
<tr>
<td>Confined_space, , ,</td>
</tr>
<tr>
<td>Ship_A, , ,</td>
</tr>
<tr>
<td>Building_B, false, default, usetypeColors.txt</td>
</tr>
</tbody>
</table>

Figure 4-4 Contents of the database configuration file

It lists all available databases of ship and building geometries and properties (as of FireGUI_2.10 there are four databases), and for each database the user preferences (or defaults) are listed:

- ‘clearUsetypes’ – if set to true no fuel loadings are loaded. If it is set to false or left blank, fuel loadings as defined by the ‘preferredUsetypes’ are loaded.
- ‘preferredUsetypes’ – if set to default or left blank, then the fuel loadings as predefined in the database are loaded, otherwise they are loaded from the file specified here.
- ‘Usertype Majors File’ – The file specified here defines the colors and patterns for the fuel categories. These colors and patterns are used to show the compartment usetypes (Section 10.1.3.2). If it is left blank, the user will not be able to view the compartment fuel loadings.

The user preferences are set automatically as the result of the user actions within the fuel loadings editor (Section 10.1.3.3). The user is discouraged from modifying this file manually in a text editor.

To modify DBConfigFile replace the text between the <DBConfigFile> and </DBConfigFile> tags. By default, dbconfig.txt is put there. The new text must provide the new location of the database configuration file. Example:

<DBConfigFile> E:\FireGUI\configuration\my_dbconfig.txt</DBConfigFile>
This is an advanced option and should be exercised, if needed, only by experienced users.

4.3.4.3 SimArchDir

SimArchDir defines the root of the FireGUI input and output file repository. Its default location is marked by the text “simRep” which is in the folder inside FireGUI deployment folder (Section 3.2.3). For some users it may be convenient to change the location of the repository, for example, to a different disk partition, or to a different disk drive.

To modify SimArchDir replace the text between the <SimArchDir> and </SimArchDir> tags. By default, simRep is put there. The new text must provide the new location of the root of FireGUI input and output file repository. Example: 

```
<SimArchDir> E:\FireGUI\repository</SimArchDir>
```

This option is needed for those users who want to keep the repository on a different disk location or a different disk than that where FireGUI is installed. It is recommended that all other users leave this option unchanged.

4.3.4.4 ExtractArchPath

ExtractArchPath defines the location where the data exported from the repository will be put. To change it, use the options.xml dialog opened from the File Menu ➔ General Options (Section 9.1.1.1).

4.3.4.5 DataViewerPath

DataViewerPath defines the location of the tool to analyze the extracted data. To change the location of the tool use the options.xml dialog opened from the File Menu ➔ General Options (Section 9.1.1.1).

4.3.4.6 SortAngle

SortAngle is used by the internal graphics routines of the FireGUI to determine drawing order of objects in the 3D view. It should not be modified by the user.
5.0 FIREGUI LAYOUT

The FireGUI consists of five major components as shown in Figure 5-1: menus, toolbars, main panel, side panel, and a compartment panel.

<table>
<thead>
<tr>
<th>Menus</th>
<th>Toolbars</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Main panel</td>
<td>Side panel</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Compartment panel</td>
</tr>
</tbody>
</table>

Figure 5-1 FireGUI layout showing five major components

5.1 Panels and Views

There are three views, which can be displayed in the three graphics panels:
- a 3D model view of the geometry
- a floor plan view, and
- a 3D view of a single compartment.

By default, the 3D model view is displayed in the main panel, the floor plan view in the side panel, and the single compartment view in the compartment panel as shown in Figure 5-2.
However, the default placement of views can be changed: the 3D view may be displayed in the side panel, and the floor plan view may be displayed in the main panel (Section 5.2). In addition, the size of the panels can be adjusted as needed (Section 5.3). The descriptions of the different views are described in Section 5.4.

### 5.2 Switch View

The views can be switched using the `SwitchView` button on the toolbar (shown in Figure 5-3), which will switch the main panel’s view with that of the side panel. This provides a quick way to swap the floor plan view to the main panel for easier selection of compartments, and then to swap it back to 3D view as desired. The view of the compartment panel cannot be changed.
5.3 Resizing Panels

By default the main panel is larger than the other ones. It can be changed by dragging the borders to the desired locations (shown in Figure 5-4).
5.4 Views

5.4.1 3D Model View

The 3D model view displays the 3D model of the ship (Figure 5-5). This view displays and allows editing the states of the active objects (i.e. state of doors, hatches, and scuttles) and displays the results of the fire and smoke simulation.
The 3D model can be rotated, zoomed in and out and moved inside the panel (Section 6.2). The view can be further customized by selecting particular fragments of the ship (as described in detail in Section 6.4), and particular ship subsystems (Section 6.6.1).

Note that in the 3D view, if all compartment surfaces are drawn, the user would not be able to see inside the compartment (Figure 5-6 Left). We have implemented a feature which, for each compartment, allows the user to see inside the compartment by not drawing the surface(s) nearest the user (Figure 5-6 Right). The hidden surfaces can be restored using the Compartment Tree Browser (Section 6.4.2).
5.4.2 Floor Plan View

The floor plan view (Figure 5-7) displays the floor plan of a ship or building. This provides a convenient way to select an individual compartment for display in the Compartment panel and to be highlighted in both the floor plan and the 3D views.

The floor plan view allows zooming and translation (moving) using a mouse. Simply click the left mouse on a compartment to highlight and display it in the compartment panel. Floor plan view is essentially an overhead view of each deck and rotation is not normally needed. To maintain this floor plan view, rotation is disabled when using the mouse. To accommodate unusual circumstances where a geometry has one compartment entirely covering another one on the same deck (two half height compartments with one above the other), the arrow keys may be used to rotate the floor plan view to pick the “hidden” compartment. More details on rotation, translation, and zooming are found in Section 6.2.

Figure 5-8 below illustrates zooming in and out of the floor plan view.

5.4.3 Compartment View

The Compartment view (Figure 5-9) shows a single compartment in 3D. This allows more detailed viewing of the surfaces (bulkheads), which make up the compartment and is where the selection of individual surfaces for specifying damage occurs (refer to Section 10.1.1.5 for more details). In the bottom left corner of the panel the compartment id, name, and deck number of the selected compartment are displayed. The compartment id (cid) is a unique integer number for compartment identification. For example, in Figure 5-9, the label “cid=47: 2-485-1-Q Nixie Elec Rm: (2-485-1), deck=2” indicates
that the compartment id is 47, name is “2-485-1-Q Nixie Elec Rm”, the three numbers in parenthesis separated by dash indicate deck=2, frame=485, position=1, and deck= indicates the deck number is 2. The current orientation of the compartment is displayed using the x, y, and z axis in the right bottom corner.

In this view, the compartment can be rotated, zoomed, and moved similar to the main 3D view with the left, middle, and right mouse buttons.

The compartment to be displayed can be selected using the Floor Plan view, 3D main view (Section 7.0), Compartment Tree Browser (Section 7.2), or Show Compartment Tool (Section 7.3).
6.0 VIEWING THE SHIP GEOMETRY

6.1 Changing Geometry

The user can load a different geometry by selecting from the drop down list of “Change Geometry” in the tool bar.

6.2 Rotating, Translating, and Zooming in the Views

This section explains how to rotate, translate, and zoom within the views.

6.2.1 Rotate

The 3D views (main 3D model and single compartment) can be rotated by moving the mouse while keeping the left mouse button pressed (preferred method) or by using the cursor keys (arrow keys) on the keyboard. The up/down arrow keys rotate about the X axis; the left/right arrow keys rotate about the Y axis. Some users prefer the control given by using the arrow keys.

For the main 3D model view, there are four modes of rotation that are controlled by the rotation tool shown in Figure 6-1.

![Rotation Tool](image)

Figure 6-1 Rotation tool in the toolbar

The modes are:

1. X Rotation
2. Y Rotation
3. X or Y Rotation
4. XY Rotation (default)

Note: The X and Y axes in this Section 6.2.1 refer to the screen axes, not geometry axes. The screen X axis runs left and right, the screen Y axis runs up and down.
6.2.1.1 X Rotation

Figure 6-2 X Rotation in the main view before and after

In this mode the ship model can be rotated only around the x-axis (horizontal one) by moving the mouse up and down. Left and right movements of the mouse are ignored. To make the above example clearer, the model has been first rotated to the front view position (Section 6.2.4.2) as shown in the left picture of Figure 6-2. The right picture of Figure 6-2 above shows the model rotated around the x-axis.

6.2.1.2 Y Rotation

Figure 6-3 Y Rotation in the main view before and after

In this mode the ship model can be rotated only around the y-axis (vertical one) by moving the mouse left and right. Up and down movements of the mouse are ignored. To make the above example clearer, the model has been first rotated to the front view position as shown in the left picture of Figure 6-3. The right picture of Figure 6-3 shows the model rotated around the y-axis.

6.2.1.3 X or Y Rotation

In this mode, the GUI picks the first mouse movement, after pressing the left mouse button. If it is up or down, it automatically switches to the X Rotation mode. If it is left
or right, it switches to $Y$ Rotation. Releasing the mouse button returns the GUI rotation mode to the $X$ or $Y$ Rotation.

### 6.2.1.4 XY Rotation

In this mode, the ship model is rotated around the geometric center of the model. The model can be rotated about both the horizontal and vertical axes simultaneously. XY Rotation is the default mode.

**Note:** By default, rotation is performed with reference to the ship center. If the user hides several compartments and/or decks (Section 6.4) the rotation may look off center as the visual center of the displayed compartments may be different from the actual center of the ship. To rotate about the displayed compartments, the NewCenter button on the toolbar can be used to recalculate the new center according to what is displayed on the screen (Section 6.4.1).

**Note:** The ship can be brought back to the initial position by hitting the “reset button” (Section 6.2.4.1).

### 6.2.2 Zoom In and Out

All three views can be zoomed in and out by moving the mouse up and down, respectively, while keeping the middle mouse button pressed. Note that the mouse should be a three button mouse. If the mouse has a wheel as the middle button, press and drag it instead of rolling it. In Figure 6-4, the original 3D view in the left picture is zoomed in some in the middle picture, and zoomed in even more in the right picture. If you do not have a three button mouse, you may hold down the Shift key and press the right mouse button while dragging it up or down to zoom.

![Figure 6-4 Zooming the main 3D view (Left: original, Center: zoomed in some, Right: further zoomed in)](image-url)

46
6.2.3 Move/Translate

Any of the three views can be moved inside their panel by moving the mouse while keeping the right mouse button pressed as shown in Figure 6-5.

![Figure 6-5 Translating the main 3D view to left and right](image)

6.2.4 Preset Positions

Sometimes after working with a model and performing rotation, zooming, and translation, the user can either become disoriented with respect to the model, can cause the geometry to move out of the viewing window, or simply desires to return the model to its default viewing position. Two buttons are provided to assist with restoration of particular views as shown in Figure 6-6. Any geometry and corresponding database could have different orientations depending on the decisions made by the AutoCAD drafter.

![Figure 6-6 Reset views and front view button positions](image)

6.2.4.1 Reset Views

This button resets the rotation, zooming, and translation to the default position in each view (3D model, floor plan, and compartment) and restores the panels to their default sizes. It also restores the MoveDecks slider to its initial position (no deck separation in the 3D model view) and restores the compartment panel to its initial state. The default position of the 3D model is with the geometry centered in the panel.

![Figure 6-7 Default position of all views and panels for Ship_A](image)
entirely visible, and viewed at an angle from the front and above (viewing angle with respect to the geometry x-axis is 90 degrees, and viewing angle is approximately 20 degrees above the geometry y-axis) as shown in Figure 6-7. Note that reset views does not restore any compartments or decks which have been hidden by the user using the compartment tree browser (Section 6.4), neither does it restore other ship elements and subsystems (Section 6.6) which have been turned off by the user.

6.2.4.2 Front View Position

The front view position displays the 3D model view in exact front view (i.e. the viewing angle with respect to the geometry x-axis is 90 degrees and with the geometry y-axis is zero). This position, shown in Figure 6-8, helps in rotating the scene easily to the required angle. Front view button does not affect the floor plan or compartment views.

6.3 Deck Separation

Decks can be separated in the 3D model to assist viewing of the interior of a 3D model. Compartments which have at least one surface which lies on the external boundary of the model (between the ship/building and the environment) can be viewed by simply rotating the model, since the surfaces of a compartment facing the viewer are made transparent. However, interior compartments completely surrounded by other compartments cannot be seen normally. The Deck Separator Slider (MoveDecks) in the toolbar (shown in Figure 6-9) is provided to separate the decks. Dragging the slider bar to the right with the left mouse button pressed will introduce spacing between the decks/floors so that viewing
of interior compartments is possible. Returning the slider bar all the way to the left removes this spacing. When the decks are not separated (Figure 6-10 Left), there are lines on the floor (or overhead) where the compartment boundaries of the deck below (above) adjoin. When the decks are separated (Figure 6-10 Right), the boundaries of the compartments below (above) will not touch the deck and their boundary lines will not be shown.

![Figure 6-10 Left: Decks not separated, floor lines are shown; Right: Decks separated, no floor lines are shown](image)

### 6.4 Hiding Decks and Individual Compartments

By clicking on the **Compartment Tree Browser** button, shown in Figure 6-11, a new dialog window (shown in Figure 6-12) pops up showing the list of compartments arranged by decks. Using this dialog, the user can select any compartments or decks to be displayed or hidden. Only checked elements are displayed in the 3D view and in the floor plan view; by default, all elements except the closed deck element (external surfaces) are checked.

The **Expand All** button expands the tree completely and the **Collapse All** button collapses the tree to show only the deck names. Double clicking on any deck name expands that deck element to show all the elements (compartments) under it as shown in Figure 6-12. Double clicking on the name of an already expanded deck collapses that deck back to a single element.

![Figure 6-11 Compartment tree browser button location](image)

![Figure 6-12 Compartment tree browser dialog](image)
Any combination of compartments or entire decks can be displayed or hidden using the check boxes. For example, in Figure 6-13, for Ship_A only deck no. 2 is checked in the tree and both the 3D view and the floor plan view show only deck no. 2.

In Figure 6-14, only 2 compartments (144 in deck 2nd platform and 38 in deck 1st platform) are shown.

6.4.1 NewCenter Button

By default, the geometric center of the entire ship is used as the center of rotation. When only a few compartments are displayed and the user rotates the scene, the compartments revolve around the geometric center of the entire ship instead of rotating around the displayed compartments. If the only compartments displayed are located far from the
center of the ship and rotation about their geometric center is desired, the *NewCenter* button as shown in Figure 6-15 can be used.

The *NewCenter* button computes a new geometric center which is an average of all the centers of the displayed compartments. The rotational center of the entire geometry can be restored when the *NewCenter* button is clicked while displaying the entire geometry.

### 6.4.2 Displaying External Surfaces

By selecting the *External Surfaces* checkbox in the Compartment Tree Browser (Figure 6-12), the external surfaces of the ship are displayed (Figure 6-16). Normally these surfaces are not drawn and only the edges of the surfaces are shown so the user can view the interior of the compartments. If some decks or compartments are hidden (Section 6.4), or if the decks are separated (Section 6.3), this will apply to the remaining visible compartments or decks. Another way to think of this is that it makes all surfaces of the visible compartments to be drawn. So it does not strictly apply to the exterior of the ship only.
6.5 Wireframe Mode

6.5.1 Surfaces

The Surfaces button shows or hides the surfaces in the 3D model view. The Wireframe mode of viewing the geometry can be achieved by turning off the surfaces (Figure 6-17).

![Figure 6-17 Left: showing both surfaces and edges (default mode), Right: Surfaces button turned off showing edges only (wireframe mode)](image)

6.5.2 Edges

The Edges button shows or hides the edges (boundary lines) of surfaces in the 3D model view. Figure 6-18 shows edges the turned off.

![Figure 6-18 Left: showing both surfaces and edges (default mode), Right: Edges button turned off showing surfaces only](image)

6.6 Ship Elements and Subsystems

The geometry of a ship is defined by compartments which are made of surfaces (bulkheads, overheads, and decks) as well as networks and junctions. In addition to the actual bulkheads there are also virtual surfaces (virtual walls or artificial bulkheads). The virtual surfaces artificially divide odd-shaped compartments into smaller, regularly shaped ones. It has been proven that the elimination of the odd-shaped compartments improves the accuracy of FSSIM prediction.
A network is a ship subsystem that usually extends across multiple compartments and typically is comprised of nodes and connectors. The databases included in the FireGUI_2.10 release define the following types of networks:

- Fire suppression system (Ship_A)
- Ventilation system (Confined_Space, Shadwell_Forward)
- Firemain (Confined_Space, Shadwell_Forward)
- Watermist (Shadwell_Forward)
- Inert Gas System (Shadwell_Forward)

Some nodes serve as active objects, that is, their state can be changed, and consequently they influence the simulations of the fire and smoke propagation; for example, dampers and fans are nodes of the ventilation system of the Confined_Space. The connectors, i.e., pipes or ventilation ducts that connects nodes, are always passive. For some networks, the user can control individually the state of their active objects, other networks can only be controlled by switching on and off the entire network, as in the case of Confined_Space framebays.

A junction is an opening that connects two adjacent compartments, allowing airflow between them if the junction is in the “open” state. The databases included in the FireGUI_2.10 release define the following types of junctions:

- Doors (all databases)
- Archways (Shadwell_Forward)
- Scuttles (all databases)
- Hatches (all databases)
- Rat holes (Ship_A)

All junctions are active objects, that is, each of them can be closed or opened. Closing an archway means blocking the airflow by a fire curtain. Rat holes cannot be closed or opened individually. Instead, the user may close or open all rat holes.

Finally, each surface can be ‘damaged’ to simulate the creation of openings resulting from a blast or other catastrophic event. A damaged surface behaves as if there was a junction added to the surface allowing airflow between the compartments that the surface separates.

### 6.6.1 Displaying and hiding ship elements and subsystems

By default, all ship elements and subsystems are displayed except for the virtual surfaces. However, each type of network and junction can be individually hidden or displayed. To enable this functionality, there is a separate button in the toolbar (Section 8.0) associated with each network and junction type, as shown in Figure 6-19. These buttons are collectively referred to as “Show Tools”.

All buttons of the Show Tool act as toggles: consecutive clicks on the buttons switch the display of the corresponding subsystem on and off. A lighter gray background with a depressed look for the button indicates that the display is switched on, and a grey
background with a non-depressed look indicates that it is off. In Figure 6-19, all buttons of the Show Tool except virtual surfaces and damaged surfaces are switched on. When a model does not have a particular subsystem and the corresponding show tool button is clicked, no action is taken.

The name, id (the database identification number), and the state of each active object can be viewed in the Object State Editor. The Object State Editor is a small pop-up window that appears (or is updated, if already displayed) as the result of clicking on the active object of interest in the 3D view. Changing the object properties is described in Section 10.1.1.

6.6.2 Networks

6.6.2.1 Suppression System

The suppression system is visualized by showing only the network nodes, which are the nozzles (Figure 6-20).
The suppression system has three types of nozzles as shown in Figure 6-21.
1. AM-18 (sidewall nozzle used for Primary Damage Area cooling) type nozzle displayed as magenta cones
2. AM-11 (thermally actuated general Class A area light hazard suppression nozzle) type nozzle displayed as cyan cones
3. AM-4 (open machinery space nozzle, UL Listed for flammable liquid hazards) type nozzle displayed as blue cones

The state of a nozzle cannot be changed through FireGUI but its state may change during the simulation, as it is controlled by FSSIM. The change of the state of nozzles is not visualized individually for each nozzle. When the suppression system is active for a compartment, the compartment is shown with white dashed edges (as opposed to changing color of each nozzle in that compartment). See Suppression System Activation in Section 10.2.2.2 for more details.

6.6.2.2 Ventilation System

Figure 6-22 below shows the ventilation system of the Confined_Space. Fans are shown as blue cubes and dampers are shown as brown spheres. When a fan is on, it is shown in
bright blue color and, when a damper is opened, it is shown in yellow. The inactive elements, mostly piping, are shown in white.

![Figure 6-22 Left: Ventilation system; Right: Two fans on and one damper opened](image)

The ventilation system of the Confined_Space has an additional feature: Framebays. Framebays were added to the model to simulate openings between the decks and hull of a confined space through which heat, smoke, and other combustion products can travel. Framebays are displayed as vertical, flat sections of the ventilation system (Figure 6-23). Refer to Section 10.1.1.6 to learn how to include or exclude the framebays from the simulation.

As opposed to the Confined_Space, the ventilation system of the Shadwell_Forward is not used for the fire and smoke propagation simulations as of FireGUI_v2.10 release. It is included entirely for visualization purposes only, and its elements have no properties.

![Figure 6-23 Ventilation system framebays](image)

6.6.2.3 Firemain, Watermist, and Inert Gas Systems

- Firemain button
- Watermist button
- Inert gas button

Figure 6-24 below shows firemain system, watermist system, and inert gas system. None of these system are currently used for the simulations.
6.6.3 Junctions

6.6.3.1 Doors and Archways

**Doors button**

This button shows or hides doors and archways. A closed door is represented by a black rectangular while an opened door is visualized by a white rectangular. A door can also be a Joiner; in which case, it is represented with a sphere in the middle. Joiner state is used to simulate a closed door but with a vent grate that is always open (the joiner door).

Archways are shown with an arch above the rectangular as shown in Figure 6-25. Archways are by definition open, but can be covered with a smoke curtain (treated the same as closed doors for simulation) as shown in Figure 6-26. Section 10.1.1 describes how to change the state of a junction.

![Figure 6-24](image)

*Figure 6-24 From left to right: Firemain system, watermist system, and inert gas system*

![Figure 6-25](image)

*Figure 6-25 Left: Doors (as rectangular shapes in black color) and archways (with semi-circular tops in white color); Right: Upper left door set as joiner (white with a sphere in center) and lower left door as opened (white) and other doors are closed (black)*
6.6.3.2 Scuttles and Hatches

Scuttles button

Hatches button

Scuttles are represented as circular disks and hatches as rectangular slabs as shown in Figure 6-27. Hatches are black in color when closed and white when opened. Scuttles are dark gray when closed and light gray when opened. Section 10.1.1.1 describes how to change the state of a junction.

Figure 6-27 From left to right: Scuttles, hatches, and upper hatch and scuttle opened

6.6.3.3 Ratholes

Ratholes button

Ratholes were added to the test area as shown in Figure 6-28 to facilitate draining of water due to activation of mist suppression.
There are three types of ratholes shown in Figure 6-29:
1. De-Watering Type A ratholes that connect compartments of the same deck. These are displayed as cuboids.
2. De-Watering Type B ratholes that connect a compartment and environment. These are displayed as short horizontal cylinders.
3. De-Watering Type C ratholes that connect compartments of different decks. These are also displayed as short vertical cylinders.

Ratholes cannot be opened or closed individually. The “Include Ratholes” checkbox in the Object State Editor Dialog (Section 10.1.1.6) changes all the ratholes to be opened or closed. All ratholes are white in color when opened.
6.6.4 Virtual Surfaces

Figure 6-30 below displays virtual surfaces (virtual walls or artificial bulkheads) as white semi-transparent surfaces. These virtual surfaces were obtained from splitting some odd shaped compartments (mainly hallways) into sub-compartments connected through junctions to aid the FSSIM network model. The splitting was done in CAD files before the geometry extraction and therefore the virtual surfaces cannot be changed through FireGUI.

6.6.5 Damaged Surfaces

The Damaged surfaces button highlights the damaged surfaces in semi-transparent blue color as shown in Figure 6-31. Section 10.1.1.5 describes how to set the surfaces to be damaged.
6.6.6 Platforms

Platforms are surfaces located within a single compartment which do not affect the simulation and are only displayed to aid in visualization for the user. For example, there may be walkways in a large space such as a machinery room that spans across multiple decks (Figure 6-32A, B, and C). There can also be vertical “platforms” that partition a single compartment space (Figure 6-32D). Thus, any surface (at any orientation) which is only present for visualization is called a platform.

Platform surfaces may blend into overheads or decks and thus may not be very obvious from certain viewing angles. The user may have to rotate the ship geometry in order to view them.

Figure 6-32 Platforms

A. Platform surfaces in machinery space viewed from a top angle
B. Platform surfaces in the same machinery space viewed from a bottom angle
C. Platform surfaces in another compartment
D. Vertical platform that partitions the compartment space
7.0 SELECTING COMPARTMENTS AND OTHER OBJECTS

The user can click on different objects such as compartments or active objects (e.g., doors, hatches, and ventilation nodes) using the left mouse button which will open the Object State Editor dialog if not already open. In the Object State Editor dialog (Section 10.1.1), the user can see or change the selected object’s state (e.g., open a closed door). Note that there is no visual indication of selecting an active object in the 3D view until the user changes the state of that object. However, the name and ID of the object will appear in the top line of the Object State Editor. Figure 7-1 shows an archway selected.

Selecting compartments is described in detail in Sections 7.1-7.3. Selecting surfaces is described in detail in Section 7.4. All objects except surfaces of a compartment can be selected using the mouse in the 3D view. Surfaces can be selected using the mouse in the compartment panel.

7.1 Selecting Compartment using Mouse Click

To select a compartment, the user can left mouse click on the compartment in the 3D view or in the floor plan view and see the selected compartment highlighted in both those views as shown in Figure 7-2. Also, the compartment panel is updated with the selected compartment and the compartment id is shown in the object state editor (Section 10.1.1) and in the compartment show tool (Section 7.3) in the toolbar. If the compartment tree browser (Section 7.2) is open, the compartment node in the tree is also highlighted. To deselect, click on the background.
7.2 Selecting Compartment using Compartment Tree Browser

By clicking on the Compartment Tree Browser button, shown in Figure 7-3, a new dialog window (shown in Figure 7-4) pops up showing the list of compartments arranged by decks. Section 6.4 introduced the Compartment Tree Browser and its usage for hiding decks and individual compartments. This tree list can also be used to select a compartment. The user can click on the compartment label of a node (the name, not the checkbox) in the tree to update the compartment in the compartment panel, highlight in green color in the 3D view and the floor plan view, and display the id in the Show compartment text box (Section 7.3), and object state editor. Clicking on the label of a node has the same effect as selecting the compartment using a left mouse click or the show compartment tool.
7.3 Selecting Compartment using Show Compartment Tool

When the compartment id is provided in the text box and the Show button is pressed, the given compartment is selected and highlighted in the 3D view and in the floor plan view. The compartment id (cid) is a unique integer number for compartment identification. The compartment is also shown in the compartment panel and the id is shown in the Object State Editor (Section 10.1.1). If the compartment tree browser (Section 7.2) is open, the compartment node in the tree is also highlighted. Show compartment tool has the same effect as clicking on a compartment in the floor plan or in the 3D view. Figure 7-5 below illustrates this feature. To deselected the highlighted compartment, click on the background or clear the text box or enter -1 for the compartment number and click the Show button.

![Figure 7-5 Illustration of show compartment tool feature](image)

Compartmment id = 152 given

Compartment node in the tree is highlighted

Compartment id is displayed

Compartment 152 shown

Compartment 152 highlighted
7.4 Selecting Surface using Mouse Click

A surface (bulkhead/deck/overhead) can be selected using the compartment panel. Since a compartment is made of surfaces, first, the compartment that contains the surface must be selected so that the compartment is shown in the compartment panel. Rotate the compartment in the compartment panel so that the surface is facing the user. Note that even though the front surface(s) are transparent, you will be selecting them rather than the back surface(s). To select a back surface, rotate the compartment until the back surface is facing you. The user can left mouse click (or right click while keeping SHIFT key depressed) on any surface in the compartment view to select it.

The selected surface is highlighted in green color in the compartment view and the state of the surface (damaged/undamaged) is displayed in the Object State Editor as shown in Figure 7-6.

![Surface highlighted in green color](image)

Figure 7-6 Surface (Bulkhead/Deck/Overhead) selected in the compartment view shown in green color and its state displayed in the Object State Editor

7.5 Highlighting Surface using Show Surface Tool

A surface is highlighted in the 3D view when the surface id (a unique number given to each surface) is provided in the text box and the Show button is pressed. Note that the damaged surfaces button is automatically turned on when the Show button is pressed. In Figure 7-7 below, you see two surfaces highlighted to show the horizontal surface 885 because the decks are separated; therefore, the floor of the upper deck and the ceiling of the lower deck are highlighted. A vertical surface would only appear as a single highlighted surface. Currently, the show surface tool only highlights the surface and does not select it. Selection of the surface to specify a damage percentage must follow the selection procedure described in Section 7.4.
Surface id = 885 given

Damaged surfaces button depressed automatically

Surface 885 highlighted

Figure 7-7 Functioning of show surfaces tool
8.0 TOOLBAR

This section summarizes the functionality of the toolbar, shown in Figure 8-1.

![Toolbar components](image)

Figure 8-1 Toolbar components

Below is a reference table (Table 8-1) showing the icon or symbol, name of the tool, description of the tool, and reference to the section which explains the details of the tool.

Table 8-1 Toolbar components

<table>
<thead>
<tr>
<th>Icon / Symbol</th>
<th>Tool Name</th>
<th>Description</th>
<th>Reference Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fire Simulation</td>
<td>Opens two dialogs that are used to run, replay, or compare fire simulations</td>
<td>Section 10.0</td>
<td></td>
</tr>
<tr>
<td>Change geometry</td>
<td>Changes the geometry (model) to the one selected in the drop down list</td>
<td>Section 6.1</td>
<td></td>
</tr>
<tr>
<td>Move (Separate) Decks</td>
<td>Slider to separate decks in the 3D view</td>
<td>Section 6.3</td>
<td></td>
</tr>
<tr>
<td>Switch View</td>
<td>Switches between 3D view and floor plan view</td>
<td>Section 5.2</td>
<td></td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
<td>Section</td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>---------</td>
<td></td>
</tr>
<tr>
<td><strong>Compartment Tree Browser</strong></td>
<td>Provides a tree structure of checkboxes to show or hide the compartments or decks</td>
<td>6.4</td>
<td></td>
</tr>
<tr>
<td><strong>Legend</strong></td>
<td>Shows color map legend</td>
<td>11.1</td>
<td></td>
</tr>
<tr>
<td><strong>Reset views</strong></td>
<td>Resets views and panels to default positions</td>
<td>6.2.4.1</td>
<td></td>
</tr>
<tr>
<td><strong>Front View</strong></td>
<td>Sets front-view position of the geometry in the 3D view (for ships this sets view to starboard side)</td>
<td>6.2.4.2</td>
<td></td>
</tr>
<tr>
<td><strong>Surfaces</strong></td>
<td>Shows or hides surfaces (walls) to toggle between solid surfaces and wireframe model</td>
<td>6.5.1</td>
<td></td>
</tr>
<tr>
<td><strong>Edges</strong></td>
<td>Shows or hides edges for each surface</td>
<td>6.5.2</td>
<td></td>
</tr>
<tr>
<td><strong>Suppression</strong></td>
<td>Shows or hides suppression system</td>
<td>6.6.2.1</td>
<td></td>
</tr>
<tr>
<td><strong>Ventilation</strong></td>
<td>Shows or hides ventilation system</td>
<td>6.6.2.2</td>
<td></td>
</tr>
<tr>
<td><strong>Water Mist</strong></td>
<td>Shows or hides water mist system</td>
<td>6.6.2.3</td>
<td></td>
</tr>
<tr>
<td><strong>Inert Gas</strong></td>
<td>Shows or hides inert gas system</td>
<td>6.6.2.3</td>
<td></td>
</tr>
<tr>
<td><strong>Firemain</strong></td>
<td>Shows or hides firemain system</td>
<td>6.6.2.3</td>
<td></td>
</tr>
<tr>
<td><strong>Doors</strong></td>
<td>Shows or hides doors and archways</td>
<td>6.6.3.1</td>
<td></td>
</tr>
<tr>
<td><strong>Scuttles</strong></td>
<td>Shows or hides scuttles</td>
<td>6.6.3.2</td>
<td></td>
</tr>
<tr>
<td><strong>Hatches</strong></td>
<td>Shows or hides hatches</td>
<td>6.6.3.2</td>
<td></td>
</tr>
<tr>
<td><strong>Ratholes</strong></td>
<td>Shows or hides ratholes</td>
<td>6.6.3.3</td>
<td></td>
</tr>
<tr>
<td><strong>Virtual Surfaces</strong></td>
<td>Shows or hides virtual surfaces</td>
<td>6.6.4</td>
<td></td>
</tr>
<tr>
<td><strong>Damaged Surfaces</strong></td>
<td>Shows or hides damaged surfaces (walls)</td>
<td>6.6.5</td>
<td></td>
</tr>
<tr>
<td><strong>Rotation</strong></td>
<td>Selects rotation mode for the 3D model</td>
<td>6.2.1</td>
<td></td>
</tr>
<tr>
<td><strong>Show Compartment</strong></td>
<td>Highlights the compartment with the given id</td>
<td>7.3</td>
<td></td>
</tr>
<tr>
<td>Surface ID</td>
<td>Show Surface</td>
<td>Highlights the surface with the given id</td>
<td>Section 7.5</td>
</tr>
<tr>
<td>------------</td>
<td>--------------</td>
<td>------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>NewCenter</td>
<td>New Center</td>
<td>Calculates new center of the model that is used for rotations</td>
<td>Section 6.4.1</td>
</tr>
<tr>
<td>Tour</td>
<td>Tour</td>
<td>This feature is not yet fully implemented. The intent was to allow the user to take a virtual tour over the ship along a fixed path</td>
<td>Not documented</td>
</tr>
<tr>
<td>Display Adjustment</td>
<td>Adjusts visualization of smoke and fire</td>
<td>Section 10.2.2.5</td>
<td></td>
</tr>
</tbody>
</table>
9.0 MENUS

There are three menus located in the upper left corner of the main FireGUI window, as shown in Figure 9-1:

- The **File** menu provides a way to modify various default settings as well as exiting the application.
- The **View** menu lets the user hide or view the toolbars.
- The **Help** menu shows various application information including version number, copyright, and contact information.

These are explained in more details in the following sections.

![Figure 9-1 Menus](image)

9.1 File Menu

The File menu provides three options: **General Options**, **Color Options**, and **Exit**. **General Options** lets the user change general settings. **Color Options** lets the user change color mappings and color settings. **Exit** exits the application.

9.1.1 General Options

![Figure 9-2 General Options dialog](image)
When the FireGUI is initialized, the *options.xml* file (and any files it references) is read and the defaults specified in it are used (Section 4.0). The General Options dialog box as shown in Figure 9-2 provides an interface to change the values in the *options.xml* file (Section 4.3). Details for changing individual fields are given in the following subsections.

The ‘Reset to Defaults’ button resets all values in the *Options.xml* file to default values. OK will overwrite the file (*Options.xml*) with the changed values and closes the dialog box. Apply overwrites the file but keeps the dialog box open. Cancel will discard the changes that are not yet written to the file and closes the dialog box.

### 9.1.1.1 Setting Global Options

Data Viewer Path, Extract Archive Path, and Color Settings File are global options that do not depend on a particular database. These values can be changed by clicking the *Browse* buttons and choosing the desired path or file.

**Data Viewer Path**

Data Viewer Path is the location of the executable of the tool (MS Excel or alternative) used to view the extracted quantitative analysis data (Section 12.5). To change the location, click the *Browse* button and choose the Excel location. Typically, the standard MS Excel installation is in the following place:

```
C:\Program Files\Microsoft Office\OFFICE11\EXCEL.EXE
```

**NOTE:** The location will likely vary depending on the version of MS Office you have installed (e.g., instead of the path containing OFFICE11, it may be OFFICE10 or OFFICE12).

Request help from your systems administrator if you cannot find the location of MS Excel or if you want to install Excel. In case the user does not have Excel installed on his/her computer, the extracted data can still be viewed using Windows notepad or any other application instead of Excel. To use notepad, choose the notepad.exe location (Typically *C:\Windows\NOTEPAD.EXE*).

**Extract Archive Path**

Extract Archive Path is the location where the extracted files for quantitative analysis will be stored (Section 12.5). As you can see in Figure 9-2, initially this field is empty. To set this path, click the *Browse* button and choose the desired location where you want to save the extracted data.

**Color Settings File**

Color Setting File defines the location of the default color map (Section 11.0). To change the default file, click the *Browse* button and choose the color map file. Alternatively, the *Use Current* button can be used to set the file currently loaded through the color map editor as the default.
9.1.1.2 Setting Database Specific Options (Preferred Usetypes)

For the user’s convenience, the fuel loading (compartment usetypes mapping file) can also be set here in General Options. Unlike the Color Settings File and other General Options, the fuel loading is database specific (i.e., different for each geometry) and is stored in another file which options.xml refers to. The Browse button can be used to pick the desired file or the Use Current button can be used to set the file currently loaded through the fuel loads editor (Section 10.1.3).

The usetype mapping values for every new simulation can be supplied from three places: the database, a compartment usetype mapping file, or clear (-1) values. The user can set this option from the General Options dialog (Figure 9-3) by opening it from the Menu bar: File -> General Options.

![General Options dialog to set the preferred usetypes mapping file](image)

The preferred file can be “Default” or a usetype mapping file. If the value is default, the database values are used as preferred values. The user can set the file by clicking the Browse button and selecting a previously saved usetype mapping file. The user can also click the UseCurrent button to accept the current usetypes file (as displayed by the Compartment Usetypes dialog box in its File Name edit box) as the preferred file. If the current loaded values in the Compartment Usetype dialog are default, then “default” is set as the preferred. Note: If there is no current usetype mapping file (Eg: the user loaded clear or default or input simulation values, modified them, applied but did not save to a file using SaveAs), then the UseCurrent button displays an error asking the user to first create a mapping file from the Compartment Usetype dialog box.

If the user wants to have all clear values for every new simulation, then the check box “Always start with the preferred usetypes” must be Unchecked. If the box is checked, the preferred values are loaded for every new simulation.
Once the user clicks \textit{OK} or \textit{Apply} on the General Options dialog, the preferred usetypes file name and the checkbox value (whether to clear the usetypes or not) are written to the database configuration file (\textit{dbconfig.txt} by default) for the displayed geometry. Note: The Shadwell Forward database currently comes with the checkbox unchecked and the preferred file as “Default” when installed.

### 9.1.2 Color options

The user can edit the color maps and change other color settings such as background color using the Color Options dialog (Section 11.2).

### 9.2 View Menu

By clicking on the Toolbar option the toolbar can be shown or hidden. The menu item “1” is not used.

### 9.3 Help Menu

The \textit{About} menu displays the credentials of the application, version number, copyright information, and contact information (Figure 9-4).

![Figure 9-4 About dialog](image-url)
10.0 FIRE SIMULATION

Creation of a new simulation consists of setting the states of the ship’s active objects (e.g., doors, hatches, ventilation fans, suppression system, and bulkheads), setting simulation parameters (e.g., duration of the simulation and ambient environment parameters), and fire propagation parameters (e.g., number of fire sources and their strength) through the GUI. When the user starts the simulation, an input file is created and passed to the FSSIM network model which produces an output file. This output file is read by the FireGUI while it is being written by FSSIM and the results are visualized.

By clicking on the Fire Simulation Tool (Figure 10-1), two new dialog windows pop up: the Object State Editor Dialog and the Fire Simulation Dialog as shown in Figure 10-2. One can move the pop-up dialogs by dragging them to the desired location. The user can close any of these dialogs by clicking the x in the top right corner of the popup. To open the dialog again, the user should click the Fire Simulation button on the toolbar.

![Image](image1.png)

Figure 10-1 Fire Simulation tool location

![Image](image2.png)

Figure 10-2 Fire Simulation and Object State Editor pop-ups
10.1 Preparing a Simulation

10.1.1 Setting the State of Active objects

The Object State Editor shown in Figure 10-3 appears when either the Fire Simulation tool button is clicked or when any object in any of the three views (3D, floor plan, or compartment) is clicked. Using the state editor dialog, the user can set the state of any active object. Each active object may be in several different states depending on its type. A junction can be either in opened state or in closed state. A door has another special state called Joiner (Section 6.6.3). A fan or damper can be on or off and a surface can be damaged or undamaged. Some objects’ initial state at simulation start time persists throughout the entire simulation (e.g. junctions) whereas others’ state may be changed by the simulator (e.g. fans or suppression systems turning on or off) during the run. The labels for the states of the active objects in the Object State Editor dialog change according to the type of the object selected.

To select an active object, click the left mouse button on the object (or place the mouse pointer on the object, press and hold SHIFT key and click right mouse button). Reminder: Surfaces can only be selected from the compartment view (Section 7.4). The selection is confirmed by the changed name and id (a unique number identifying each object type) in the top field in the Object State Editor dialog box. Once the object is selected, select the state by clicking on one of the options provided.

The change of state is visualized by a change in object color. In general, a light color corresponds to an on/open/damaged state and a dark color to an off/closed/undamaged state. For example, an open door is white, a closed door is black. An open damper is yellow, and a closed damper is brown.

All objects of similar type can be globally set to a particular state using the set all objects button (applies only to door, hatch, scuttle, or archway). After a particular object is selected, choosing opened or closed, and clicking the set all objects button will set all objects of that type to that state. For example, clicking any hatch, then choosing opened, and clicking the set all objects button will set all hatches to opened state.
10.1.1.1 Doors, Hatches, and Scuttles

Doors, hatches, and scuttles can be set to closed, or opened. In Figure 10-3, door 65 has been selected and set to open. Joiner state (Section 6.6.3) is applicable only to doors.

10.1.1.2 Archways (Smoke Curtains)

An archway can be changed from archway to a smoke curtain. Smoke curtains are treated as closed doors for simulation purposes. For a new simulation, all archways are in the archway state (i.e., on) and all doors and other objects are closed (or off).

10.1.1.3 Ventilation System

The ventilation nodes, like fans and dampers, can be turned on or off. FSSIM v1.2 does not support interactive changing of states during runtime. However, a delayed change of status can be declared prior to the model execution using the Active State Switch Time text box. For example, in Figure 10-4, the ventilation node 118 (fan) is scheduled to change its status from on to off after 60 seconds of simulation time. The change of state always means a transition from one state to the opposite: e.g. from open to closed or from off to on.

10.1.1.4 Suppression System

Suppression nozzles are turned on only by FSSIM and thus their states cannot be set by the user. For the Ship_A geometry, there are two conditions which must be met before a given suppression nozzle will be turned on. First, there is a preset temperature which depends on the nozzle type and cannot be changed by the user. Second, there is a global delay (set point) which prevents the suppression system from turning on prior to the specified time – even if the temperature is above the preset value. A text box is provided for changing the set point for the suppression system. The default value is 240 seconds for the Ship_A geometry. The granularity of suppression system activation is per compartment, since FSSIM only maintains a single temperature value for the entire compartment.

10.1.1.5 Surfaces

A surface (bulkhead/wall/overhead/deck) can have a state of damaged or undamaged. Surfaces cannot be selected from the 3D view; they can only be selected from the compartment panel. For details on how to select, refer to Section 7.4. The selected surface is shown in green color in the compartment panel. The surface id (a unique number given to each surface) is shown in the Object State Editor dialog. Change the state to Damaged and give the percentage area of the damage in the text box. To see the
damaged surface shown in semi-transparent blue color in the 3D view (not the compartment panel), turn on the Damaged Surfaces button (Section 6.6.5).

10.1.1.6 Ratholes and Framebays

De-Watering Ratholes in Ship_A or Framebays in Confined_Space can be included or excluded in the simulation using two check boxes on the Object State Editor. The checkboxes are shown only if the geometry has the corresponding feature as shown in Figure 10-5 for Ship_A. For more information on ratholes and framebays, refer to Section 6.6.3.3 and Section 6.6.2.2 respectively. All the ratholes act as a single unit. Therefore, changing the state for individual ratholes is disabled. All ratholes are shown in white color when included. Including or excluding Framebays does not provide any visual effects.

10.1.2 Setting Simulation Parameters (Simulator tab)

The fire simulation dialog box shown in Figure 10-6 is used to set the simulation parameters. It has three tabs: Simulator, Replay, and Compare. The simulator tab is described further in this and the next section. The replay and compare tabs are described in Section 12.1 and Section 12.2. Note: If you do not see the entire dialog box as shown here (i.e. if the bottom is cut off), then increase the screen resolution to the minimum recommended (Section 3.1). You may also try hiding the Windows task bar which would give a little more screen space at the bottom for the dialog box.

Simulation parameters include name of the input file (simulation name) created for the particular run and a simulation description, the requested duration of the simulation, external conditions (ambient temperature and pressure), initial concentration of oxygen (assumed to be constant throughout the entire ship), and fire sources.
10.1.2.1 Simulation Name, Description, and Duration

The user specifies the simulation name, description, and duration using the Fire Simulation dialog controls shown in Figure 10-7. For the user’s convenience, the FireGUI automatically generates a unique, default simulation name, but since it is done automatically, the generated names are usually not user friendly. The users are encouraged to type new names according to whatever naming convention suits them best. The only restriction is that it must be a valid file name to be accepted by the Microsoft’s Windows operating system (alphanumeric characters, dashes, underscores, dots, and spaces only). The user can also type a description for the simulation which will be useful in identifying the simulation. The description and name of the input...
file are used for identification of the simulation for subsequent replay or comparison. The duration of the simulation is specified in seconds.

10.1.2.2 Ambient/General Parameters

Ambient conditions can be edited using the Ambient / General Parameters dialog that can be launched by clicking the “Ambient/General...” button on the Fire Simulation dialog as shown in Figure 10-8. The ambient values, such as temperature, oxygen, and pressure, can be edited in the dialog.

![Figure 10-8 Ambient conditions](image)

10.1.2.3 Structural Material

The user can change the structural material of the ship. For the Shadwell_Forward geometry, the user has three options to choose from: Carbon Steel, Aluminum-5000 series, or Aluminum-6000 series. The simulation input file is created based on the selected material by taking the material properties from the database. Carbon Steel is the default material of the ship for any new simulation. The structural material can be changed by clicking the drop down list of “Struct. Material” in the Fire Simulation popup as shown in Figure 10-9 and selecting the desired one from the given list. This has the effect of changing, for example, all steel surfaces to aluminum-5000 series surfaces, with corresponding changes to the material properties, such as thermal conductivity, emissivity, and heat capacity.
Note: As of v2.10, this feature is implemented only for Shadwell_Forward geometry. The drop down list will not be shown for any other geometry.

While it is possible to change the material for each individual bulkhead or a horizontal surface, the FireGUI does not support changing it interactively. Making such changes requires expert knowledge of this software, and it is not described in this manual.

![Figure 10-9 Structural material selection](image)

**10.1.2.4 Fire Sources**

A simulation can have several fire sources, each of which may have different settings. The controls in the Fire Parameters part of the Fire Simulation dialog, shown in Figure 10-10, are used to define the fire sources. Each fire source has a location and parameters associated with that fire.

A new fire source is created by clicking the *Add Fire* button and can be removed by using the *Delete Fire* button. To add a fire source, click on a compartment in the 3D view or floor plan view to select it (highlighted in green color), and then click the *Add Fire* button in the Fire Simulation dialog. The highlighted compartment is added to the fire sources location list. Once a fire source is added, it can be changed to another compartment if required by double-clicking the compartment name in the *Location* list to open a drop down list of all compartments and selecting another compartment from the list.

![Figure 10-10 Fire parameter controls showing fire source in location compartment 104 'passage'](image)
Any compartment which contains a fire source is outlined with pink color edges by default and small tick marks extending into the compartment as shown with black arrows in Figure 10-11. The tick marks enable a user to know whether or not a given compartment is on fire when totally surrounded by other compartments which are on fire. In other words, even if the compartment has pink edges but no tick marks point into it, then it is not on fire (shown with white arrow in Figure 10-11). During a fire simulation run, a compartment which initially is not on fire can catch on fire. In that case, it is shown with pink edges. Also, fire in a compartment may be extinguished by the suppression system in which case the pink edges are not shown. Thus, apart from the propagation of heat and smoke, we can also see the propagation of fire from one compartment to another.

10.1.2.5 Fire Parameters

Each fire source has a unique set of parameters that include location (compartment), fire type (constant, $t^2$, or $u$setype), fire subtype (power or speed, depending on which fire type was selected), fire starting and ending times, fuel parameters and others. Note that a $u$setype fire uses the fuel loading present in the compartment and therefore does not have a subtype.

If multiple fire sources are defined, then the user must first specify which fire source’s parameters are to be changed. The user can click on the fire source entry in the Location table to select it (highlighted in blue color). Once the fire source is selected, its parameters can be changed as desired. Figure 10-12 shows two fire sources listed, with the fire source in the compartment id=275 ‘Chilled Water …’ location selected and highlighted and its parameters (type, speed, start, end) are shown.

When a new fire source is first added, by default the fire type will be constant in time with a power of 100kW if the fire source compartment has no $u$setype assigned. If the
fire source compartment has a usetype assigned, then the fire type defaults to usetype. If the user changes the fire type to constant or $t^2$ while the compartment still has a fuel loading (usetype) defined, then FSSIM ignores the fire type and uses the compartment’s fuel loading (usetype fire).

The user can change the fire type and subtype by selecting from their respective drop down lists. Figure 10-12 shows a $t^2$ type fire of ultrafast subtype.

$t^2$ power is the maximum heat release rate for a $t^2$ source fire. The default value is $10^9$ kW. $t^2$ time is the maximum growth period for a $t^2$ source fire. The default value is $10^5$ sec. These two values can only be set for a $t^2$ type fire.

The Start time is the time from the simulation start that the initial fire source fire begins. If nothing is specified, the default is 0 which means that the fire begins when the simulation begins. End time is the time from the simulation start that the initial source fire ends. The fire may end earlier due to suppression or oxygen consumption. If nothing is specified, the default is $10^5$ sec. Figure 10-12 shows the start and end times as 30 and 120 seconds respectively.

The fire source fuel parameters can be edited using Fuel Params dialog that can be launched by clicking the "Fire Src. Fuel Params.." button on the Fire Simulation dialog as shown in Figure 10-13.

![Figure 10-13 Fuel parameters button and editor](image-url)

"Fire Src. Fuel Params" button. Click to launch popup

Fuel Parameters popup is launched. Edit values and click OK to save.

82
If the fire type is Constant or $r^2$, the Fuel Params popup is filled with default values as recommended by FSSIM. The user can edit these values for a new simulation and click OK to accept for the simulation.

If the fire type is usetype, the Fuel Params popup is filled with the values taken from the Fuel corresponding to the compartment's usetype. The values cannot be edited for a usetype fire and are grayed out, but the user can change the compartment’s usetype as shown in the next section. Note: If the user selected the fire type to be usetype but the fire source compartment has no usetype assigned, then default values are shown in the popup as there is no fuel associated.

10.1.3 Setting Fuel Loading (Compartment Usetypes)

Each compartment may have a fuel loading defined, which is the type and quantity of fuel present. A fuel may be an average of all of the different types of combustible materials present in a given compartment. This usually is a factor of the compartment’s purpose or usetype. Usetypes are predefined in some of the databases and many compartments are pre-assigned a usetype (mapping compartment to usetype). The user can pick from any of the predefined usetypes to set/change/remove the fuel loading for any compartment. Alternatively, if a compartment’s usetype is unassigned (has not been predefined or the user makes it unassigned), when setting a fire source in that compartment, various fuel parameters and fire type can be specified at that time, effectively setting the fuel loading.

10.1.3.1 Usetype Representation

As mentioned above, each usetype consists of a fuel and an amount associated with it. Each fuel has a major type, which represents a grouping of similar fuels, and a minor type, which is a subcategory, and is represented with a two part label consisting of a letter and a number. For example, Living Space (L) is a major type and passageway (L1), hotel space (L2), and others are minor types of L. The amount is the density of the fuel in kilograms per square meter. For example, the L1 fuel may have five different amounts (50, 40, 30, 20, and 10 kg/sq. meter).

In the FireGUI, we use a combination of color, pattern, and a shade of the color to represent a usetype. The color represents the major type of the fuel. For example, Living Space (L) is green, General Stores (A) is red, and Command and Control (C) is orange. The pattern represents the minor or subtype of a fuel. 1 is shown with no pattern, 2 with diagonal lines sloping downward to the right, 3 with diagonal lines sloping downward to the left, as well as other patterns. The shade of the color represents the amount of the fuel (the darker the shade, the higher the amount). For example, the values 40, 30, and 20 of fuel L1 may be assigned dark green, medium green, and light green, respectively. Figure 10-14 shows color, pattern, and shade combinations for Living Spaces (L).
In the database of every geometry, each compartment is assigned a specific usetype id or -1 if no usetype is assigned. This assignment of usetype id to the compartment is referred to as “compartment usetype mapping” or “compartment fuel loading”. A specific usetype id refers to the exact fuel and exact amount of that fuel.

10.1.3.2 Viewing Compartment Ussetypes

The compartment usetype mapping can be viewed using the “Compt. Ussetypes...” button on the Fire Simulation dialog (shown in Figure 10-15). When the “Compt. Ussetypes...” button is clicked, the compartment usetype mapping values are displayed in Compartment Ussetypes dialog pop-up. These values are obtained from one of three places: from the database, from a mapping file, or from an input simulation file (loaded using the simulation, replay or compare tabs of the Fire Simulation dialog). The mapping values can also be all ‘Clear’ meaning that all compartments have unassigned usetype (-1).

Whenever the “Compt. Ussetypes...” button is clicked, the application switches to the ‘usetypes-mode’ with the floor plan view chosen in the main panel, each compartment color coded according to its assigned usetype, and a legend being shown with the colors and usetypes as shown in Figure 10-16. When the Ok or Cancel buttons are clicked on the legend, the application switches back to the regular mode (restoring the views to the state prior to invoking the compartment usetype editor and restoring the floor plan view compartment colors back to the default wall color so that simulation results such as temperature and oxygen can be shown).
The legend for the usetypes is represented with color and pattern boxes for each fuel and for each amount in the database. The compartments that are in gray color have an unassigned usetype (-1). A tooltip for each color box provides more information such as the label and amount. The tooltip can be activated by pausing with the mouse on the box. The user can click on any compartment to highlight the usetype in the legend. The user can also click on the color box of the legend and all the associated compartments are highlighted (with a white and black border) in the floor plan view.

Figure 10-17 shows three selected compartments highlighted in the floor plan and their three usetypes highlighted in the legend. It also shows the tooltip for a usetype representing fuel L2 with amount 40 kg/sq. meter (hotel space with CPO berthing [40]).
Figure 10-17 Three compartments are selected and tooltip is displayed for a usetype

10.1.3.3 Loading, Editing, and Saving Usetypes

Loading and editing operations are permitted only for the simulation tab of the Fire Simulation Dialog. For replay and compare tabs, loading and editing are disabled. The dialog (legend) itself acts as the editor. An overview of the dialog controls is given in “Usertype Dialog Controls” below. More details are given in subsequent sections “Loading” and “Editing and Saving”.

Usertype Dialog Controls:

- **File Name**: Displays the source of the loaded usetype values (mapping file name / Default / Clear / <InputSimulationName>_UT).

- **Apply and Edit / Cancel Edits**: “Apply and Edit” applies the loaded values and puts the legend into the edit mode. “Cancel Edits” cancels the edits that were NOT applied and puts the legend into the non-edit mode.

- **Load File**: Loads usetype values from a previously saved compt. usetype mapping file for the same geometry. The usetype mapping file consists of CompartmentID and UsertypeID separated by a comma for each compartment. **Note**: Make sure to
• **Default Loads**: Loads default usetype mapping values from the database.

• **Preferred Loads**: Loads the preferred usetype file values. The Section 9.1.1.2 describes how to set the preferred file using File->General Options.

• **Clear**: Loads all compartments with unassigned usetypes (-1).

• **SaveAs**: Saves the current usetype mapping values into a compt. usetype mapping file and changes the File Name to point to the newly created file.

• **Apply**: Applies the changes and overwrites the file shown in the “File Name” edit box if it is a real file. (e.g., if the loaded values came from Default / Clear/ <inputsim>_UT, it does not write to any file as there is no mapping file associated with the loaded values). It keeps the dialog box open for further modifications.

• **OK**: Same as Apply but also closes the usetypes dialog box.

• **Cancel**: Just closes the usetypes dialog box without doing anything else.

**Loading:**

The user can load the usetypes for a simulation using one of the following methods:

1. Load from a compt. usetype mapping file using the “Load File” button
2. Load default mapping values from the database using the “Default Loads” button.
3. Load the preferred usetype file values using the “Preferred Loads” button.
4. Load all unassigned usetypes (-1) using the “Clear” button.
5. Load usetype values from an input simulation file by loading the input file from the Fire Simulation dialog’s “Load Input” button (Section 12.3).

Once the mapping values are loaded and if the user is satisfied with the values, he/she can click **OK** button to accept the usetype values for the next simulation and close the **Usetypes Dialog**. But if the user wants to further edit the values, he/she can click the **Apply and Edit** button on the legend (shown in Figure 10-18).

**Editing and Saving:**

Once the user clicks the **Apply and Edit** button, the loaded values are applied, the legend goes into the ‘edit-mode’, renames the **Apply and Edit** button to **Cancel Edits**, changes the title of the dialog to show that the legend is in edit mode, enables right clicking on the legend for editing, and disables all the load buttons. If default or clear values are being edited, the file name is prefixed with asterisks (**default or ***clear). At any point of time during editing, the user can accept the changes made till then by clicking the **Apply** button.
The user can click the *Cancel Edits* button at any time to cancel the edits that are NOT applied and go back to the non-edit mode. (NOTE: Once the user clicks the *Apply* button, the edits cannot be cancelled. Clicking *Cancel Edits* button after *Apply* only puts the legend in the non-edit mode and enables the load buttons if the user wants to load any other file).

Once the legend is in the edit-mode, compartments can be selected for editing by clicking the compartments in the floor plan view with the left mouse button. Multiple compartments can be selected by pressing the Ctrl key on the keyboard and left clicking with the mouse on the compartments. The selected compartments are highlighted (with white and black border) in the floor plan view and their usetypes are highlighted in the legend. More compartments can be selected or the compartments that are already selected can be deselected by using the Ctrl key and left clicking. All compartments of a particular usetype can be selected from the legend by clicking the left mouse on the desired box (say L1 with amount 40). Holding the Ctrl key for multiple selections does not apply to the legend.

Once the desired compartments are selected, now click on the legend color box with the RIGHT mouse button to SET the desired usetype for all of the selected compartments. The compartments are set with the chosen usetype and are shown with the changed usetype. The user can repeat the above steps to edit more compartment usetypes.

Figure 10-18 shows editing three compartments to have Jr. Officer Berthing usetype and Figure 10-19 shows those three compartments with the new usetype after editing.
Figure 10-18: Editing usetypes for three compartments.

Three selected compts.

In Edit mode

Apply and Edit / Cancel Edits button

Right click to set the usetype

Figure 10-19: Three compartments showing new usetype after editing.
After this step, the user must click the *Apply* or *OK* button to accept the changes. The *Apply* and *OK* buttons save the values for the next simulation and OVERWRITE the file displayed in the “File Name” box if a file exists. The edited usetypes values are carried over to the next simulations until the user clicks *NewSim* button or *LoadInput* on the Simulation tab of the Fire Simulation Dialog.

Note: If the user started with Default or Clear values, edited them, and clicked *Apply* to save, the values will go into the next simulation but are not saved to any file or to the database. Therefore any changes made will be lost once the application is closed or the *NewSim* or *LoadInput* buttons from the fire simulation dialog are pressed. However, the values would get saved to the simulation input file if you run a simulation after editing the values. The user can permanently save the edited values explicitly to a usetype mapping file by using the *SaveAs* button. If the user desires to use these values for every new simulation—even after restarting the software—then follow the directions under General Options (Section 9.1.1) for setting the preferred compartment usetypes mapping file.

10.1.3.4 Advanced User Options

A look-up file (*usetypeColors.txt* by default for the Shadwell_Forward database) is provided for specifying the colors for the fuels. This file name is given in the database configuration file (*dbconfig.txt* by default) for every database. All the major fuel types are described in this file with Label, description, and color values (R,G,B) for background color and foreground color (i.e., pattern line color). For example, an entry for living-space may have (L, Living space, 0.0,1.0,0.0, 1.0,0.0,0.0). In this case, all the compartments of usetype L are represented in some shade of green color with some pattern of red color lines. Note: This file is provided along with the other installation files and only the advanced user who understands how to represent a color in RGB values should edit it.

10.2 Running and Viewing Simulations

10.2.1 Running

The simulation is executed by the *Start*, *Pause*, *Resume*, and *Stop* buttons. The *Reset* button resets the visualization of simulation results in the GUI.

Information from several different sources (the ship geometry stored in the database, the simulation parameters, and the state of the active objects from the GUI) is used to generate an input file (i.e. Fortran namelist file) for FSSIM.

The *NewSim* button opens a new simulation run and resets the current settings to their default values. The *LoadInput* button is used to load an input file. The *ShowInput* button generates the input file and opens it in notepad. This feature can be used for debugging
purposes. The data fields (e.g. Save input as, Duration) have default values. The Simulation Description default value is the name of the input file if no description is given by the user. Ambient conditions such as temperature ($T$), pressure ($P$), and oxygen ($O_2$) also have default values and can be changed by the user.

The creation of the input file occurs every time the user clicks the Start button or the ShowInput button and will overwrite any existing input file having the same name unless the user has checked Use as is (Section 12.3).

If the Start button was clicked, the Object State Editor is hidden and the status box located above the radio buttons is set to “Preparing …” as shown in Figure 10-20. If incorrect data is entered (e.g. fire source not defined or duration is not an integer number), an error message box is shown and the status line is set to “Error…”

After the file is successfully generated, the system starts FSSIM and begins processing its output step by step. The simulation status in the status box is set to “Running…” and the simulation time is shown using an analog clock, a digital clock, as well as a progress bar as shown in Figure 10-21. The digital clock provides exact time; the analog clock makes it easy to compare the rate of simulation with real time, while the progress bar gives an estimate of how much time is left until the end of simulation. The user may pause or suspend this process, resume execution of a suspended simulation or stop it by clicking on the corresponding button as shown in Figure 10-22.
10.2.2 Viewing Results

The results of the simulation are displayed either by changing the color of the compartment surfaces (temperature, toxicity, and oxygen concentration) or by changing the opacity of the compartment (smoke). The results are visualized in both the 3D view and the floor plan view (shown in Figure 10-23). The color map legend can be displayed by clicking the legend button from the toolbar.

![Figure 10-23. Simulation results (oxygen) shown in 3D and floor plan views](image)

10.2.2.1 Show Parameter

The buttons to right of the analog clock allow selecting the parameter to be displayed: temperature and smoke, temperature, smoke, toxicity, or oxygen (shown in Figure 10-24). Also note that if surfaces are hidden you may not be able to see the parameter display except for smoke (e.g., if a compartment has an elevated temperature but no smoke, then the temperature display may not be visible until surfaces are displayed again). Currently, the only two parameters that can be shown simultaneously are temperature and smoke. Figure 10-25 shows the

![Figure 10-24 Show parameter buttons](image)
results of selecting some of the show parameter buttons.

10.2.2.2 Suppression System Activation

The FSSIM network model is a one-zone model, i.e., it produces only one value per compartment. Therefore, the suppression system is either activated or not activated for the whole compartment. Thus, a compartment with suppression activated is visualized with a white dashed edge. If that compartment is also the fire source location, it is displayed with a pink and white dashed edge; otherwise, with a black and white dashed edge as shown in Figure 10-26 below.

Note that we need to run simulations beyond the set point time (Section 10.1.1.4) to see the activation of the suppression system.
10.2.2.3 Fire Spread

A compartment on fire is shown with a pink border (fire source color, Section 11.4) and small ticks pointing into the compartment. At the start of the simulation, only the initial fire source compartments are on fire. As the simulation progresses, the neighboring compartments may catch fire based on their fuel loadings and they will then be shown with the pink border also, as shown in Figure 10-27.

10.2.2.4 Active Objects State Change

Active objects, such as fans and dampers, may change their state during the simulation based on their switch time set by the user. For example, if the switch time of a fan is set to 60 seconds and its initial state is set as ‘on’, then the fan changes its state to ‘off’ after 60 seconds into the simulation. FireGUI visualizes on and off states of fans and dampers using different colors as shown in Figure 10-28.
10.2.2.5 Display Adjustment Tool

All show parameters except smoke are visualized using color, and smoke is visualized using dark gray plus transparency, with full visibility (no smoke) as fully transparent to zero visibility (heavy smoke) as fully opaque. In the show parameters, we have the feature of showing temperature and smoke at the same time. By blending the color with gray and changing the opacity of this blended color surface, we show both temperature and smoke simultaneously.

Simultaneously displaying temperature as color and smoke as dark gray is challenging. Consider the situation of high temperature and low visibility: High temperature alone would give a fully saturated (e.g., bright red) color, which prevents showing a dark gray surface (low visibility). This is counterintuitive, since a compartment full of smoke is expected to be dark (not bright red). On the other hand, if we allow the compartment full of smoke to be very dark gray, then the information about the temperature is lost, because color is hardly perceptible. A compromise must be found. We provide a control “color from temp, %” so that the fully saturated temperature color can have an upper limit placed on it to preserve a gray component.

Showing heavy smoke as a fully opaque surface would prevent seeing anything in the interior of the compartment. We provide a control “opacity upper value, %” to limit the opaqueness of the surface.

By experimentation, we determined that good results are obtained if the high value of temperature is mapped to 75% of color saturation and the high value of visibility is mapped to 95% of opacity as shown in Figure 10-29. These experimentally selected values result in a realistic representation of smoke while providing perceptible information about the temperature.

Using the Display adjustment tool, this mapping can be adjusted to the user’s liking.

Figure 10-29 Display adjustment tool
11.0 COLOR MAP AND LEGEND

11.1 Legend

The Color Map Legend tool (Figure 11-1) displays the legend for color mapping of temperature, visibility, toxicity, or oxygen. Only one parameter is shown at a time with the exception of temperature and visibility which can be shown simultaneously. To select a parameter, click on the drop down list and choose from the list. If the legend dialog box is open and the user changes the show parameter using the buttons to right of the analog clock in the Fire Simulation dialog, the legend is updated to reflect the displayed parameter. The visibility legend shows a white vertical bar in the middle which disappears as the visibility decreases (observed toward the top of the legend).

Figure 11-2 shows the legend for Temperature and Visibility.

11.2 Color Map Editing using Color Options Dialog

The user can edit the color maps using the Color Options dialog that can be opened by clicking the Edit button on the legend (shown in Figure 11-2) or by selecting File → Color Options from the menu bar (Section 9.0).
When the Color Options dialog as shown in Figure 11-3 is opened, a preview legend is also shown. This preview is updated as soon as any change is made in the color map. The name of the XML file used as the ColorSettings file is shown at the top of the dialog. The ‘Reset to Defaults’ button resets all the values of the current file to default values. The Load button is used to load another ColorSettings file. The ‘Save As’ button is used to save the current file in a different location and/or as a different file name. Once the file has been loaded or saved as a different file, the Color Options dialog will start using the new file, whose name is reflected in the title bar. OK will overwrite the file with the changed values and close the dialog box. Apply overwrites the file but keeps the dialog box open. Cancel will discard the changes that are not yet written to the file and close the dialog box. Section 9.1.1.1 explains how to change the default colormap loaded at startup using Color Settings File.

This dialog box has two tabs, Color Maps and Color Settings, as explained below.

### 11.3 Color Maps Tab

Simulation results are visualized by mapping data values to colors (referred to as color mapping). The Color Maps tab allows one to modify the color map values and colors for four parameters: temperature, toxicity (carbon monoxide concentration), oxygen concentration, as well as opacity for smoke visualization.

For example the default color map for temperature is as follows:

- Below 40C (default units are Celsius C) -- no color is shown (only the default compartment surface color) as the conditions do not impact activities of humans.
- Between 40C and 60C -- color intensity increases from default surface color to yellow, i.e. transition between a safe region and a region where humans need protective equipment.
- Between 60C and 165C -- color stays constant yellow. In this region the color does not show any differences to varying temperatures, as long as the values are in the range where humans with protective equipment are safe.
- Between 165C and 185C -- color goes from yellow to red (transition between the limited access and no access regions).
- Above 185C -- color remains at saturated red indicating uninhabitable areas for humans.

Toxicity and Oxygen are also shown by coloring the compartment surfaces. The loss of visibility due to smoke is visualized by opacity rather than color.
11.3.1 Color Map Representation

Before proceeding further, let us understand how a color map is represented. A color map contains several rows with color (or opacity) and a value associated with that color. A given color is at its full intensity at its given value. Above that value, the color slowly graduates to the next specified color value. The first entry always has the wall color and its value represents the starting point for the color gradation. Figure 11-4 shows a sample linear color map.

At value 20, the gray color starts to graduate into the purple color and at 65, the color is pure purple. After 65, the purple color slowly transforms into the next color i.e., the blue color. Blue is at maximum intensity at value 110 and graduates to the next color above its value in the table.

For a step color map, there should be two consecutive rows with same color but different values. Figure 11-5 shows a sample step color map.

Both row 2 and 3 have yellow color with different values. This means that the color becomes intense yellow at value 15 and stays the same until value 13. Below 13, the color transitions from yellow to red.

Note: All values in any color map should be monotonic (i.e., either in decreasing or in increasing order). In any color map, there should be at least two rows. The first row has the wall color and another row has some other color and value. For visibility, instead of color, opacity values are specified which range from 0 to 1 (0 is transparent and 1 is opaque).
11.3.2 Color Map Tab Controls

Figure 11-6 shows the color maps tab. Using the ‘Select Parameter’ drop down list, color map parameters like temperature and visibility can be selected. Units can be changed using the Units drop down list. The selected color map is shown in the table. The ‘Select Color Map’ drop down list is used to change the existing color map type to a new one. It provides the starting point to edit the color map in the following three ways.

1) Default Step will reset the table to the default step map.

2) Linear will provide two rows and enables the linear map controls. The user can set the linear map by providing a Start Value and selecting the Start Color button, and then clicking on the desired color in the spectrum and repeating the same for the end color (i.e., set End Value, choose End Color, and click on the spectrum). The range between the start and end value is divided equally among the chosen colors. The number of rows present in the table after selecting a start color and an end color will generally vary between 3 and 8 rows, with the predefined spectrum colors (violet, blue, cyan, green, yellow, orange, and red).

3) Custom map provides two default rows in the table.

The table is filled with the new map and can be modified as desired using the table controls. Note: Once the color map is stored from the table, its type is shown as a custom color map and the starting type (default step or linear) is not remembered.
11.3.3 Editing the Color Map

The table contains four columns. The Index column shows the sequence number of the color. The Color column shows the color. When viewing the table for the visibility parameter, the color is always the wall color. Opacity applies only to visibility and is disabled for other parameters. The Value column specifies the value at which the specified color is at its full intensity. The value field can be edited by double clicking in that field. Values should always be either in ascending or in descending order.

A row has to be selected by clicking on it before using any of the following buttons. The ChangeColor button is used to change the color of the selected row. Click the button and choose any desired color from the color chooser box. InsertRow inserts a row with default values after the selected row. DeleteRow will delete the selected row.

After editing, the user may continue with other parameters by selecting from the ‘Select Parameter’ drop down list or the user may click OK or Apply to write the modified color map to the file shown in the title bar, or click Save As to save under a different name.

11.3.4 How Color Mapping is Done

The color starts at range1 and increases until range2, i.e. the color is at its full intensity at range2. For step mapping, give gaps between ranges (Figure 11-7). For linear mapping, continuous ranges should be given (Figure 11-8).

![Figure 11-7 Step color mapping](image)

Color1: Yellow 100 to 200
Color2: Red 300 to 450
11.4 Color Settings Tab

This tab (shown in Figure 11-9) is used to change the GUI background color, compartment wall color, and fire source color by clicking the associated Select button and choosing the desired color from the color chooser box. The fire source color is used to outline the compartment that is on fire. Click OK to save and close the color options dialog. Note: It is advisable not to change the wall color.
12.0 ACCESSING DATA FROM PREVIOUSLY RUN SIMULATIONS

12.1 Replaying Simulations (Replay tab)

Since all simulations (both settings and results) are stored in the simulation repository, a simulation can be replayed at a later time by using the replay tab in the Fire Simulation Dialog as shown in Figure 12-1. In replaying, the results are read from an existing file and not generated in real time.

There are two modes in replay: 1) Visualize and 2) Extract Data. Visualize mode is used to see the simulation results of a run. Extract data mode is used to extract data from the output of a run for quantitative analysis as described in Section 12.5. By default, visualize mode is selected. To replay a simulation, the user must select from the list of available simulations. Click on the select button, and the Available Simulations Dialog shown in Figure 12-2 will pop up, which contains the names of the input files and the descriptions of the simulations.

Select a simulation (by clicking on the name of the input file or description). The selected simulation becomes highlighted. Click on Load to confirm the selection or Cancel to close the dialog window without selecting a simulation. The remaining four buttons are explained in Section 12.4. Note that this dialog shows simulations that have both the input file and its associated simulation output file (.csv) files. Thus, if an input file is created but not executed, it will not be shown in the available simulations.
After a simulation is chosen, the selected input file is read and simulation parameters, such as duration, fire sources, structural material, fuel loadings, and states of the ship’s active objects are set. All of these parameters and states can only be viewed using the GUI but cannot be edited. To start replaying, press the Start button. The functionality of the rest of the buttons is the same as described previously.

The replay tab also allows the user to control how the simulation is replayed. Replay (reading from a file) is much faster than real-time simulation. To slow down the replay, the user may request a delay (pause) between time steps. On the other hand, for very long simulations, the user may also request skipping time steps (e.g. displaying every tenth time-step) making the replay even faster. Figure 12-3 points out the different options to control replay of a simulation.

The FSSIM network model uses a variable time step during the simulation. While replaying, the user may select a constant rate of time steps (called time sampling which corresponds to a variable temporal rate) or a constant temporal rate (called step sampling with variable amount of time steps skipped).

Go to the time step

Time sampling

Step sampling (10 indicates show every 10th step)

Slow down the replay (Pause 0.2 sec after showing each step)

The user may also skip the beginning of the simulation and jump directly to a specified simulation time by giving the time in the text box located to the left of the Goto button and clicking the Goto button. The Next button can be used to go to the next step.

12.2 Comparing Two Simulations (Compare tab)

Comparison of two simulations is an extension of the replay mode to replay two simulations, simultaneously. When the Compare tab of the Fire Simulation dialog window is clicked (Figure 12-4), the panels are resized so that two panels with the main 3D view are shown with each occupying half the screen.
Two previously run simulations are selected by clicking the two Select buttons or both runs can be selected simultaneously (use CTRL key to select multiple selections) from the same Select button. The simulations can be controlled in the same way as a simple replay (except that time sampling is disabled for comparisons). To see the fire parameters associated with each simulation, click in the description text box of that simulation; the fire location, type, power, and other parameters are displayed in their respective fields.

The simulations are replayed when the user clicks start button. Note that if two simulations have different durations, then the results are shown for the least duration (e.g. Sim1 runs for 100 sec and Sim2 run for 150 sec, then comparison is done only for the first 100 sec).

In compare mode, holding down the Ctrl key in conjunction with the normal mouse button actions (rotation, zooming, and translation) will simultaneously affect both compare panels rather than just the one the mouse is in.

Figure 12-5 and Figure 12-6 show comparison of previously run simulations in different views.
12.3 Repeating a Simulation from an Existing Input File

Instead of creating an input file from scratch, the LoadInput button in the Simulator tab can be used to load an existing input file to get the simulation settings used in that file. When the LoadInput button is clicked, the Available Inputs dialog (as shown in Figure 12-7) is opened with a list of available input files. After the desired file is selected from the list and the Load button is clicked, the fire sources, simulation parameters, such as duration, and states of the active objects, are loaded into the GUI and can be changed by the user thereafter. If it is desirable to keep the original file unchanged, the “Save Input As” field should be changed to a new user supplied name. Otherwise, the original file would be overwritten whenever the ShowInput or the Start button is pressed. A warning popup appears to remind you that the file is about to be overwritten.

Figure 12-6 Comparison of simulations in the floor plan view by using the SwitchView button for Shadwell_Forward

Figure 12-7 Available inputs dialog
Note: Only the parameters that were set from the FireGUI will be loaded from the existing file. The other required parameters will be read from the database before recreating the file. One exception to this is when the “Use as is” checkbox is checked. In this case, the file is not overwritten or recreated, but submitted to the simulator without modification. Be aware that if you load an input file, change the settings and then check “Use as is”, your changes will be overwritten by the settings from the original file. Once you check “Use as is”, changing the simulation parameters or the active object settings is disabled. The “Use as is” checkbox is only enabled after loading an input file.

12.4 Importing, Exporting, Renaming and Deleting Simulations

The popup Available Inputs (as shown in Figure 12-7) or Available Simulations (as shown in Figure 12-2) has buttons for importing (e.g., from another user), exporting, updating, or deleting file(s). Import and Export popup dialog boxes are shown in Figure 12-8. Inputs refer to only an input file, whereas Simulations refer to a pair of files – the input and the associated output file. These operations can be performed on multiple files simultaneously (selected using CTRL or SHIFT key on the keyboard). When importing an input file or simulation, or exporting to give to another user, please note that the geometry database should be the same or problems or even a crash of the software is possible.

For renaming, first double click on the Name and/or Description column and change the text as required. Then keeping this row selected, click the Update button. If the name column is changed then both the input file name and the associated output file name are renamed. Note that changing just the output file name has no effect.
12.5 Data Extraction for Quantitative Analysis

This feature enables extracting simulation output data for quantitative analysis of the results. The user can export the data for external analysis packages, such as Microsoft Excel in the form of a comma separated values (.csv) file. If Excel is not available, other applications such as Notepad may be used. Please make sure that the Data Viewer Path in File->General Options (Section 9.1.1.1) has the correct location pointing to the Excel executable or an alternative before proceeding further.

The raw results of all the simulation runs are stored in the simulation repository (simrep) directory and are stored in a format best suited for visualization. After a simulation run is complete, the user can visualize the results once again using the Replay tab of the Fire Simulation popup dialog (Section 12.1). The simulation output file contains full results of the simulation. In order to extract a subset of the data (one or a few compartments and one or a few variables) for analyzing the results of specific compartments quantitatively using plots, the new feature exports data in a format better suited to Excel (a .csv file) or other analysis applications.

12.5.1 Extracting Data

On the replay tab of the Fire Simulation popup dialog, the Extract Data mode lets the user select one or more compartments, select one or more variables, and specify the time range to extract simulation data into a csv (comma separated values) file for further analysis. After selecting the desired simulation from the Available Simulations dialog (obtained by clicking the Select button in the Replay tab), select the Extract Data mode (shown in Figure 12-9) to open the Data Extraction dialog. As soon as the Extract Data mode is clicked, the Fire Simulation dialog and the Object State Editor dialog are hidden and a new Data Extraction dialog as shown in Figure 12-10 pops up.

![Figure 12-9 Replay tab showing two modes (Visualize and Extract Data). As soon as the Extract Data mode is clicked, this dialog is hidden and a new data extraction dialog pops up.](image)
Three items required for extraction of the data are the compartments, the variables, and the time range.

1. **Selecting compartments**: The user can select as many compartments as he/she wants. There are two ways to select the desired compartments:
   a. First way is to click in the checkboxes of the tree in the data extraction dialog (Figure 12-10) to select or deselect the compartments.
   b. Second way is to click on the desired compartment in the 3D scene to select it. When the user clicks on any compartment in the 3D scene, the label of that compartment is highlighted in the tree and a check mark is placed for that compartment. In order to deselect any selected compartments, the user has to uncheck the checkboxes by clicking in them from the tree. The user cannot deselect by clicking in the 3D scene.

2. **Selecting variables**: The user can select any variables by clicking on the checkboxes. All variables are selected by default.

3. **Selecting the time range**: The user can select any range of the time (from 0 to the max time step) in seconds by giving a start time step and an end time step in the edit boxes. The default is 0 to the max time step.

After all the above are selected, the Extract button has to be clicked to start the data extraction process.
12.5.2 Saving the Extracted Data

Once the Extract button has been pressed, a Save As dialog box (shown in Figure 12-11) is displayed with the Extract Archive Path (Section 9.1.1.1) as the default location, a unique name with the simulation name as the prefix for the file name to be extracted, and a default file extension as .csv (comma separated values). All or any of these three (file location, file name, and file extension) can be changed according to the user’s preferences. If the user chooses a different location to archive the files, that location is used as the default the next time any file is extracted until the application is closed. Once the application is started again, the Extract Archive Path last stored in the options.xml file is used as the default location for storing the extracted files. If the Extract Archive Path has not been set as of the first extraction attempt, the user will be prompted to set it.

![Image of the Save As dialog where the user can change the file name, location, and file extension](image)

The progress of extraction is displayed at the bottom of the extraction dialog in the Extraction progress label. The extracted data is written into the specified file in the given location and is displayed to the user using the application specified as the Data Viewer automatically. For example, Figure 12-12 shows the MS Excel application which was started automatically when the extraction finished with the Excel file displaying the temperature data for two compartments (20 and 21) from time step 0 to 300 seconds. In MS Excel, an XY plot of these values can usually be obtained by selecting all the data including headings (from cell A1 in this example to cell C314) and then clicking the menu item to insert a “Scatter plot with straight lines”. Many plot variations and properties such as titles and labels are available in Excel. The details of how to use depend upon the version of Excel being used.
Note: The values of the variables like temperature and pressure are in the same units as used by FSSIM V1.2 i.e., time is in seconds (s), temperature is in Kelvin (K), pressure is in Pascal (Pa), Heat release and Fire size are in kiloWatts (kW), yield soot is in kg soot/kg gas, yield CO is in kg CO/kg gas, and yield O₂ is in kg O₂/kg gas. FireGUI extracts the raw data as output by FSSIM and does not do any conversion of the units.

Once the extraction is complete, the user can select different parameters from the extract dialog and click the extract button to create another extraction file or he/she can click the Cancel button to go back to the Fire Simulation dialog. Another simulation output can be selected from the Replay tab and the extraction process can be repeated.

Note: MS Excel currently has a limitation that it cannot load more than 256 columns or 65000 rows in a single sheet. So if the extracted file exceeds these limitations, it will not be displayed completely in Excel.
13.0 SUMMARY

This manual describes the functionality of the Fire Model Network GUI V2.10 developed by Mississippi State University in conjunction with Hughes Associates, Inc. and the Naval Research Laboratory. The GUI provides an environment to setup, run, and visualize fire and smoke simulations.

For further support, please contact Tomasz Haupt at haupt@cavs.msstate.edu
14.0 REFERENCES


APPENDIX A: OVERVIEW OF V2.10 NEW FEATURES (SINCE V2.8)

A.1 Fuel Loading (Compartment Usetypes) Editor

A new feature which allows the user to select the fuel loadings for compartments has been added. This lets the user set the compartment loadings to all default values, undefined/clear (no loading), or pick from a table of fuel loadings. The fuel loadings can be saved to a file for later reloading, to make a new default file, or to give to another user.

A.2 Ship Structural Material Selector

The ship’s basic structural material can be changed from a new menu item on the Fire Simulation Dialog. This globally changes all surfaces (bulkheads, decks) of a given material to another material. E.g., Steel can be changed to Aluminum-5000 series. If other materials are also present (insulation/thermal), they are not changed.

A.3 Reorganization / Enhancements of the Fire Simulation Dialog Controls

In order to accommodate the new features of fuel loading and ship structural material selector, the ambient conditions and fire source fuel parameters have been moved from the Fire Simulation dialog to new popup windows since they are infrequently accessed. In place of these parameters, new buttons were added to access the new features.

Adding a fire source is now more user-friendly. The user can simply select a compartment and click the Add Fire button to add the compartment as a fire source. The default fire type is determined based on the fuel loading of the fire source compartment.

A.4 Shadwell_Forward Database Enhancements

Shadwell_Forward database has been enhanced to add new decks and extend some of the decks in the previous model, more than doubling its size from 77 compartments to 159 compartments. Also, there are default fuel loadings defined (compartment to usetype mappings) for most compartments of Shadwell_Forward.